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Using SensorView

SensorView provides a large variety of configuration options to fine tune the connected nLight
network. This section covers common configuration and management tasks that arise when setting up
and maintaining the network over time; as well as step by step instructions for accomplishing a given
task.

The Device Tree: The Device Tree is the foundation for navigating through SensorView and easily
locating a specific device, profile, etc. It is always located in the far left side of the screen, and works in
the same fashion as standard collapsing menus do in other programs. Select which feature of the Device
Tree you wish to learn more about

e Device Tree Overview
Tree Layout
Search / Filter / Locate Device
o View Device State
e View Device Status
e Selecting Multiple Devices

FloorPlan: A feature providing a visual layout of the space for the purposes of device and zone selection
and interaction. Contact us to have a layout produced for your nLight installation.

Once a layout is produced and you have received the layout (.mvdb) file, it can be imported into
SensorView by going to Admin > Map and clicking the “Import” button, then browsing to and selecting
the file.

Software and Firmware Updates

o Updating Sensorview: This process walks you through upgrading to the latest version of
SensorView, and ensures you are running on the latest build, including the newest patches,
compatibility fixes, and features. This process can only be run by authorized administrators of
SensorView’s host machine, they cannot be performed via the web interface.

o Updating Device Firmware: Each nLight device has internal software that can be updated,
usually to add new functionality. This process will ensure your devices are all running on up-to-
date firmware, and can only be performed by authorized nLight network administrators.

Common Procedures: The menu items on the left are the procedures most commonly asked about using
SensorView. If a procedure you are trying to perform is not included in this list, please contact us at
tech@sensorswitch.com and we will look into adding it for future revisions.

e Loggingin
e Administrative Tasks

o Creating Users
o Modifying Users
o Gateway Page
o Location Page
o View Device Properties
e Viewing / Editing Device Settings
o Normal Devices
o Scene Selectors / nlOs

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 1 0of 123



mailto:controls.quotes%40acuitybrands.com
mailto:tech@sensorswitch.com

<AcuityControls.

nLight. .
SensorView Manual

e Viewing / Editing Zone Settings
e Managing Profiles
o Create a Profile
o Edit a Profile
o On Demand Profiles
o Delete a Profile
e View Reports
e Upgrading Devices

SensorView
e Step 1: Requirements
o Step 2: Pre-Installation
e Step 3: Installation
e Step 4: Connecting to Gateway

Virtual Wallpods

e Configuring SensorView
o Update SensorView
o Virtual Wallpod Server
o Virtual Controls
o Virtual WallPod Switch
o Control Zone

e Virtual WallPod Application

e jOSApp
GreenScreen

e Setting up PostgreSQL
e Setting up Database Connection
e Setting up GreenScreen

SensorView Page Mapping

Overview

Qogl DAl

Green Screen

Admin: The Admin tabs are for administrators only, and will not be accessed by a day to day end user.

e Setup

e Updates

e Databases
e Plugins

e Reports
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Navigation Tabs: Across the top of all pages within SensorView are the Navigation Tabs. Depending on
a user’s permissions only some of these may be available. To learn more about each tab, click from the
list below:

o Devices

Control Channels
o Local Channels
o Global Channels

e  Group Settings

e Profiles

e Schedules

e Users
Glossaries

e SensorView Terms
e Status Icons
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The Device Tree Menu, available from the arrow to the right of the search textbox, contains selection
features that aid in the location / selection of devices. Three primary types of search features

exist: Features, Profiles, and Device States. Features allows for selecting / searching of the tree based
on predefined characteristics of the device, such as whether it has a relay or occupancy sensor; available
options are: current-sensing, occupancy, daylighting, relay, dimming, switch, dimming-or-relay.

nLight Network

Features

-switch I £
raining Roo

»

current-s=ensing

relay

¥ Back Bridge dimming-or-relay mﬁim
oCCupancy wireless
¥ Lobby photocell
POD-GFX, Back Doo
“ 0= r Profiles
¥ Lunch Area

ben's profile  ben's schedule 1
nIQ, Row 4, Left F

nIQ, Row 4, Right
nlO, Row 5, Left emor  offline
nlIO, Row 5, Right normal  waming
nlQ. Bow & Left

Device States

Profiles locates or selects devices that are in a particular profile; this is useful when creating a new
profile that operates on all the devices already in an existing profile. As profiles are added or removed
from the system the contents of this selections will change. Device States allows for searching or
selecting devices depending on their current state.
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Tree Layout

The layout of the SensorView device tree corresponds closely with the actual wiring of the devices, with

a few notable exceptions:

Bridges are not nested within
their parents

Find devices

[Training Room

Devices in a zone are displayed in
alphabetical order, not wiring
order

Zones off a bridge are displayed
in ascending alphabetical order

Admin Green Screen og v Tew Admin Green Screen

nLight Network nLight Network

Find devices Find devices
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Search / Filter / Locate Device
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The SensorView tree allows for the user to select or search for devices based on a variety of
parameters. The Device Tree Menu contains numerous options for searching for (“finding”) devices
based on predetermined characteristics (such as device state, or features the device has). The text field
above the device tree also allows for free text search over the devices. A user can type any value into
the field and the tree will automatically begin filtering to display devices with label(s), model(s), or
device ID(s) matching the entered value(s).

nLight Network
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Device States

There are two primary ways to quickly locate a device: use the device Search, or the prebuiltFeatures.
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1. Device search (filter) allows a user to immediately begin typing to search for the device (over
device ID, model, or custom label), while
2. Features allows for a user to search for a device based on its
o Hardware capabilities:
= current-sensing, dimming-or-relay, occupancy, photocell, relay, switch, wireless
o Profiles
= Select by Profile name
o Device state
= error, normal, offline, warning

Note that any device matched and displayed will automatically cause the parent zone, bridge, and
gateway to be displayed. When operating in MultiSelect (link) mode, clicking on the parent nodes will
select all the currently visible child nodes, and will omit the ones that have been filtered out.
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For any device selected from the Device Tree (left), SensorView displays data in real time by selecting
one of the available tabs: Properties, Current Settings, Default Settings, and Status. This example shows
the readings from one of the nLight Ceiling-Mount, Passive Dual-Technology sensors covering
approximately an area of 9 meters in diameter (nCM PDT 9) in the Zone called “Mike”, which has been
selected from the device tree menu.

Log Out (quest

Control ( Y
Channels

Default Settings | Status

¥ Upstairs Gateway [A\ <«

¥ BRIDGE 1 B 12 3 6 9 noon 3 6 9 12
» IT Room

¥ BRIDGE 2
» Hallway - Restroom
> Jay
» Lobby
» NAA
P Unisex RR 1
» Unisex RR 2

¥ BRIDGE 2
» Josh =
¥ Mike

nCM PDT 9 (00000D45)

nlO next to door

Sunday, June 3, 2012 » "“

{111}

nlO next to door
nlO over desk

nlO over desk
nPODM DX WH (001A454C)
nPP16 (D0OD1E34)

» Port 7

nCM PDT 9
Standard Range 360° Sensor - Ceiling Mount,
Low Voltage, Dual Technology (PDT)

¥ BRIDGE 4
» Ben's Office
» Jarrod's Office

» Open Office - North
» Open Office-South
» Open Office - North
» Open Office-South

Find new gatewa

¥ Basic info

Device ID:

Firmware Version:

00000045
F183E0042-003 / B1S3E002E

Network Depth:
BACnet Instance:

Associated Profile:

291

Mike's Office

¥ BRIDGE S
» Conference Room ¥ Advanced details
» Kitchen Date Code: 3908
» Mens Room Zone: Mike (on BRIDGE 3) =

There are 6 possible states that an nLight device can be in. These different generally indicate some sort
of operational problem with a device.

Note: “Device State” (shown below) is not the same as Device Status. Individual device types can have
various “status” conditions, depending on their functions.

e Offline — The device is no longer online, check that the device is properly connected
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e Out of Range — The device is online, but communication is restricted due to insufficient signal
strength. This applies to nWiFi devices only. Signal strength for wireless may vary under certain
conditions. Devices downstream from an nWiFi device may also appear Out of Range, if the
parent is.

e Bootstrap — The device failed a firmware update and is in bootloader. Any relay or dimming
output will be toggled on, but the device will not respond to any operational changes. Update
the device to resolve this.

e Misread — Some properties of the device were not read by the gateway. To resolve state, go to
the device and select “Rediscover” or use Group Select->Rediscover

¢ Incompatible — SensorView is not compatible with this device and is unable to configure it.
Upgrade the device to resolve this.

e Mismatched — SensorView has detected that the devices’ settings do not match what is
expected. Synchronize the device (either using SensorView or device’s settings) to resolve.
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View Device Status

The Status Screen displays the present state of any device selected in the left tree menu. Device types
have different functions. The status pages display parameters specific to the type of device selected,
indicated by icons easily seen at glance.

Green Screen  Overview

nLight Network

¥ Training Room
Back Bridge
nBRG 8
nBRG 8 (D00F7D60)
nBRG 8 (00168B5A)
nBRG 38 (001C1819)
nBRG 8 (001C184C)
nBRG 8 (001C1854)
¥ Upstairs Gateway
¥ BRIDGE 1
¥ IT Room

nCM PDT 9 (00002267)

nPP16 (0D000B21)

¥ BRIDGE 2
p Hallway - Restroom
> Jay
» Lobby
P NSA
P Unisex RR 1
P Unisex RR 2
¥ BRIDGE 3
» Josh
> Mike
B Port 7
¥ BRIDGE 4
» Ben's Office
» Jarrod's Office
¥ BRIDGE 5
» Conference Room
» Kitchen
» Mens Room

Log Qut {quest)

—
Control

.W
nfl?il-lT SENSORVIEW Channels

Profiles Schedules

Properties | Current Settings | Default Settings §3 &1

—Occupancy, Relay & Dimming

m State: Open

Occupied: No

Pole State Reason: Zone
Unoccupied

—FPIR & PDT

Tracked Occupancy Timer:
00:00:00

—Scenes & Profiles

FEEEEL =
. Scene Active: No 0 Profile Active: No

—Broadcasting & Tracking Channels
a

©e i
' Tracking Occupancy on channel: 1

a
- R | Tracking Switch on channel: 1
=

J: Tracking Photocell on channel:

.

—\oltage

/ Port1: 21 / Portz: 21

-
% Temperature: 20°C / 68°F
L7 ‘1

The current state of the device for each parameter (icon) is also displayed in readable text, which may
include additional information on the particular status of the parameter within the selected device.

For a complete guide to Status Icons or possible conditions for a given device parameter, visit the Status

Icon Glossary.
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Selecting Multiple Devices

In certain contexts the Device Tree will allow for users to select multiple devices, rather than just

one. This mode of selection is available on Group Settings, Profiles, Global Channels, or Users. This
mode of selection greatly enhances the ability to quickly create system schedules, permissions, or make
wholesale changes to device settings.

To select multiple devices:

e Check multiple boxes, each new device will be added to the selection. Checking a selected
device a second time will remove it from the grouping.

e Check aZone / Bridge / Gateway to select all of the devices within that group. Check that
grouping structure a second time to deselect all devices within that Zone / Bridge / Gateway

group.
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Admin Green Screen Log Log Out (scottl)
Devices F:nntrnl . Schedules
Channels
8 selected TREE / MAFP  Profiles Settings
l I % [[tew I Delctc B Run Ber ule 1 Save
¥ Training Room | | « Synchronized
Back Bridge | [ )] Scott Test Time Delay =
Samole Profile 1
. T
NS oC ule
B L | Add an exception 54
nBRG 8 (00168B5A) ]
nBRG 8 (001C1819) | | Special Modes D
nBRG 8 (001C184C) ]

nBRG 8 (001C1894) All Devices Semi-Auto :
¥ Upstairs Gateway |Add an exception E|
¥ BRIDGE 1
¥ IT Room
nCM PDT 9 (00002267)
nPP16 (000D0B21)
¥ BRIDGE 2
> Hallway - Restroom
» Jay
» Lobby
» N/A
P Unisex RR 1
P Unisex RR 2
¥ BRIDGE 3
P Josh
» Mike
P Port 7

|f-\dd a setting

1

Schedule 1 of 1 x| Update |

Recurrence: | Weskly :

Maon Tue Wed Thu Fri Sat Sun

OO0OVMO® O

Every |1  weeks

EEEEEEEEEEEEEN

E=piration:
|'-a"|

¥ BRIDGE 5 | Does not end
F Conference Room L ~# Stops running and recurring at
P Kitchen | | ¥ 12:00am on |7/17/12
[ Find new gateways ]

Selecting multiple devices is useful when large amounts of devices are to be operated on
simultaneously. Profiles, Users, Group Settings and Global Channels all support multiple device
selection. All other modes operate in single select, such that selecting any item in the tree displays
information specific to that device.
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Bridge Selected
(Parent gateway
checked in gray)

None Selected
(empty Checkboxes)

Zone expanded. Specific zone devices
All zone devices checked unchecked

nLight Network

Find devices Find devices
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Updating SensorView

Please note that the following procedure must be done from the SensorView host computer, and cannot
be initiated over the web; administrator credentials on the host are also required.

Note: Always retrieve the latest installer to perform the actual update, on occasion SensorView updates
will require subsequent device updates, should this occur the installer will warn you before proceeding
with the update.

Depending on the currently installed version of SensorView the steps to update the software may vary,
for all versions less than 7.0, follow steps A and B. Otherwise, proceed to step B.

A. Updating to 6.14:
1. Visit Updates page in SensorView & initiate upgrade to 6.12.xx:

—

n..iﬂHT N R

2. Return to the Updates page & initiate upgrade to 6.14.xx.
3. Return to Updates page & run all available updates on firmware:

Return to Updates page & follow instructions to update to 7.x.x:

—

Hijﬂ'HT ]

B. Updating to the latest version:
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1. Download SensorView installeﬁ[DAZ] and run Setup.exe

2. Select Modify when offered and follow the prompts.
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3. Return to Updates page & run all available firmware

updates.

Dewices |

e ) ) il
NLIGHT sinsommw

Plugins

Seraoeiw - Insialihuekd Woand
Seteg Glate

0

e

The st okt Wizard = by Sl

& et veriien of SessaiView 3 wvadable, 11 13630688, mould you bie
b upgenta to it

[ v Ho

Software Updates

Curne® wirseon: 7.1.134, 30669
Biew verson: 7.2.139.30721

T volpte softwere;
T. Sebect Modily and chol Mexi

Galeway Updates

Traanang Rocm

Firmware Cache Updates

Curment varson: 201 1.09.07
MNew wersion: 2012.06.36

1. Om the server (E-update] nes the Sitaller

00445004 1.1.30736-2.8.30.1

1.1.30645-2.6.30.1 Mo

Downgrading to Version 6.12.x

If you need to return to SensorView Version 6.12 for any reason, run the 6.12.x installer. Note that you
will have to uninstall the current version of SensorView beforehand.
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Updating Device Firmware

Select the Admin button at upper left, then select the Updates tab to view all available
updates. Devices will be omitted from the listing if they are currently up to date.

SensorView will retrieve the latest firmware for each device from the internet. If you are not going to
have internet then download and install the firmware cache (top right), which will allow firmware
updates to be performed offline.

—
Control

Channels Settings.

Databases

Software Updates Firmware Cache Updates
Current version: 7.1.136.30688 Current version: 2012.06.26
New version: 7.2.141.30796 firmware cache is up-to-date

To update software:
1. Run the installer
2. Select Modify and click Next

Sensor Updates

Gateway 1D New FW# Status
Ceiling Sensors

nCM ¢ ADC 0046D52C FFFFFFFO Z-006-D Z-009-E

wallPod Updates
[

L nPODM 2P DX WH 00458831 FFFFFFFO v-E Z-002-F Incompatible

Power Pack Updates

]
(1] nPP16 003D8F3B FFFFFFFO Z-002-D Z-004-E Incompatible
[ nSP5 D 0045AA75 FFFFFFFO Z-005-D Z-008-E Incompatible

Update Selected

The status of the update is displayed in the rightmost column of the blue Status bars, and also at the top
center of the screen:

1. Status: Pending while “Preparing to update firmware ...”
2. Status: In Progress while “Updating firmware: X% done”
3. Status: Completed Fast when “100% Done”

While firmware is being updated by the system, the actual physical device will display a very fast blink of
its green status light, as well as closing relays and dimming to full bright, as appropriate. As the process
nears completion, the device will display a slow, blinking pattern. After a few minutes, the device status
light will return to normal.
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Overview 100% Done

[- —— Control
nLIGHT sensorview Channels Settings.

Updates Databases

Software Updates Firmware Cache Updates
Current version: 7.1.136.30688

Current version: 2012.06.26
New version: 7.2.141.30796

firmware cache is up-to-date
To update software:

1. Run the installer

2. Select Modify and dlick Next

Sensor Updates

)
[

[l nCM 9 ADC 0046D52C FFFFFFFO Z-009-E Z-009-E Completed Fast

WwallPod Updates
[}

(1] nPODM 2P DX WH 0045B831 FFFFFFFD Y-E Z-002-F Incompatible

Power Pack Updates

)

(] nPP16 003D8F3B FFFFFFFO Z-002-D Z-004-E Incompatible

1 nsPs D 0045AATS FFFFFFFD Z-005-D Z-008-E Incompatible
Update Selected

Repeat this process for all devices by selecting any and all (at once) which require firmware updates.

When all devices have been updated, the red Incompatible conditions on the screen will be replaced

by Completed Fast.
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100% Done

P—
{ Control )

)
) —_—
" P = y
I'IGEH T sensorview | Coricc Channels Settings

Databases

Software Updates Firmware Cache Updates
Current version: 7.1.136.30688 Current version: 2012.06.26
New version: 7.2.141.30796 firmware cache is up-to-date

To update software:
1. Run the installer
2. Select Modify and click Next

Sensor Updates

L
L
| ) nCM S ADC 0046D52C FFFFFFFO Z-009-E Z-009-E Completed Fast

WallPod Updates

|-
L nPODM 2P DX WH 0045B831 FFFFFFFD Z-002-F Z-002-F Completed Fast

Power Pack Updates

L
L nPP16 003D8F3B FFFFFFFO Z-004-E Z-004-E Completed Fast
] nsSPs D DD45AATS FFFFFFFO Z-008-E Z-008-E Completed Fast

(Update Selected)

Navigate to the SensorView login screen via the Start Menu, desktop shortcut, or by directly typing the
address into the web browser (note: address requires entering the Host Specific Computer Name, which
is installation specific):

http://<Host Computer Name>/SensorView

Login

User Name

Passwerd  [ETTI
[ Loo- |

Sencaviw

Enter your case sensitive username and password. Default login is:
Username: administrator
Password: admin

If you have forgotten or do not have your login information, please contact your network administrator.
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Administrative Tasks

Only administrative users have authority to perform these tasks, which involve modifying / creating
users, as well as modifying properties on the Gateway & Location pages.

Creating:

1. Click the Users tab

Log Out (administrator)

{ Contro Grou { :
. S | ) ( Group 7 f - W A [ e |
nﬁ;HT STNSORVIE Devices | Channels | | Settings | Profiles r Schedules | Users

Overview

Recent Activity

Firmware on 003A7988 was updated to Z-013-F (8:54 AM)
Firmware on 003A79A9 was updated to Z-013-F (8:53 AM)
Firmware on 003A787E was updated to Z-013-F (8:51 AM)
Firmware on 003A7875 was updated to Z-013-F (8:49 AM)

2. Select Add a User from the dropdown

Admin Green Soreen Log Oheervicw Log Out (administrator)
i 3 [ Devices | | COntEos [ Profiles |
NLIGHT sensonview - Channels | [
nLight Network User Accounts
L 1> s -
¥ Training Room P Add a user

¥ Back Bridge admimistrator
Email Password
Labby
Lunch Area
Supply Closet Confirm password
nBRG &8

- RSSO fARAETRE AL
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3. Fill out all fields, making sure to set the appropriate access level.

User Accounlts

[ Add a user |+ eleic user Jif Sove |

User details

Username Password
Ermail Confirm password
Type

basic |E|

Virtual switches

[.'.:I-.. Sl I|| [Z elete Swilch

4, Click Save

User Accounts

Add a user v Delete user m

User details

Username ) -_'-'assv\-l:l'd
OO0 [ 300000

Emiail Confirm password
OO [ 30000

Type

basic |E|

Virtual switches
[ Add Switch | [ Delete Switch |

New Switch ‘

Switch label (opbonal):
|E| Mew Switch

.

Select zone:
Select zone

]

Control type:

Zone Channel 3

Modifying:
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1. Click the Users tab

Log Out (administrator)

J— > o % %W ¥ X
- ) Control \ Group : - )
- . ! ! 5 | re !
G;HT SINSONVE Devices Channels | | Settings | Profiles l Schedules Users

Overview

Recent Activity

Firmware on 003A7988 was updated to Z-013-F (8:54 AM)
Firmware on 003A79A9 was updated to Z-013-F (8:53 AM)
Firmware on 003A787E was updated to Z-013-F (8:51 AM)
Firmware on 003A7875 was updated to Z-013-F (8:49 AM)

2. Select user from the dropdown

Admin Green Soreen Log i Log Out (administrator)
f_‘ . [ Bevs \ (" Control 0 \ ".7"
NLIGHT sensorview S Channels | cttings | | "UES
nLight Network User Accounts
| | > e Pl les
¥ Training Room P Add a user
¥ Back Bridge adrmamstrator
Emnail Password
Lobby
Lunch Area
Supply Closet Caonfirm password
nERG &

- RSSO fARAETRE AL
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3. Change the appropriate information
Admin Green Screen Log o Log Out {administrator)

PESN——
T Contral y (T G
QOEES At Profiles Schedules

B Channels Settings

HT SENSORVIEW

nLight Network User Accounts

I I > Iadministratnr Delete user [l Save
-

¥ Training Room
¥ Back Bridge ]
Lobby Email Password
Lunch Area | |
Supply Closet Confirm password
nBRG 8 |
¥ nBRG 8 (D00F7D60)
Bathroom
Bathroom

O

¥ nBRG 8 (00158B5A)

User details

Virtual switches
[Add Switch| [Delete Switch |

- Switch label [optional):
Training Area |E| |Lclbb‘_|,' 1
nBRG 8 (001C1819) Switch type:

¥ nBRG 8 (001C184C) |E| [ Two Pole Dimmer
Port 2

¥ nBRG 8 (001C1894) Select zone:
Port 8 Lobby (Back Bridge) [=]

Port 1 Control type:

¥ Training Annex Room = Zone Channel
Annex
Bathroom
Classroom Channel 1
Kitchen [ACLED
Office Gotham Cans

Peerless Pendant
Storage RTLED
¥ Upstairs Gateway TLED

¥ BRIDGE 1 VTLED
IT Room

¥ BRIDGE 2
Hallway - Restroom
Jay

4. Click Save
User Accounts
[save]
User details
Email Password

Confirm password
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Gateway Page

The Gateways tab allows operators to manage the nGWY devices that are currently managed by
SensorView. nGWY devices running on the same IP Subnet will be discovered automatically by
SensorView; any nGWYs that reside on different segments of the IP network can be added by simply
entering their IP address on the Gateways tab.

Note: Discovering nGWY devices on different segments of the IP network may require for firewalls and
routers to be updated to allow access to the necessary ports.

Including / Excluding Gateways:

1. Click the Admin tab

Admin Green Screen

Log Out (administrator)

Log
)
) > { Conirol )  Group ) = )
nG;HT SNSOMIEW Devices ’ l e | ‘ Settings 1 [ Profiles Schedulesl Users

Overview

Recent Activi

Firmware on 003A79BB was updated to Z-013-F (8:54 AM)
Firmware on 003A79A9 was updated to Z-013-F (8:53 AM)
Firmware on 003A787E was updated to Z-013-F (8:51 AM)
Firmware on D03A7875 was updated to Z-013-F (8:49 AM)
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2. Click the Gateways section to expand it

Setup Updates

Databases Plugins

SensorView Server -

Gateway 000003FC
Gateway 004488BA

Time Zone and DST as:

Gateway Password

Gateways

Mail Server

America/MNew York El

For sunrise/sunset (astronomical time
offzets):

Choose nearest location:

Country:

Us [~]
State:

Connecticut Izl
City:

MNew Haven |Z|

Latitude North Longitude East
(Degrees, Minutes) (Degrees, Minutes)

m

-
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3. Make any changes to the existing list, such as whether or not to include a particular Gateway

Setup Updates Databases Plugins

Location

Gateway Password

Gateways
Gateway IP: | :]
10.65.67.52 Upstairs Gateway Online
10.65.67.102 Training Room online

4. Add IP addresses of any required Gateways not auto-detected (requires IP address).
5. Click Save to apply your changes

Location

Gateway Password

Gateways
Gateway IP: | :]
10.65.67.52 Upstairs Gateway Online
10.65.67.102 Training Room online
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Location Page

Properly configuring the location for all nGWY devices and the SensorView host is required to ensure
that all profiles will run at the proper time. Setting the time zone allows the nGWY devices to properly
update their time throughout the course of the year as Daylight Savings Time comes into effect. The
location parameters allow the nGWY devices and SensorView to properly compute the correct Sunrise
and Sunset times for a given day.

Viewing/Editing Gateway & Server Locations:

1. Click the Admin tab

Admin Green Screen

Log Out (administrator)

Log
)
. > { Control )  Group ) ( 3 \
I'IG;HT SENCORIEW Devices l [ il l [ Setfings I l Profiles Schedules Users

Overview

Recent Activi

Firmware on 003A79BB was updated to Z-013-F (8:54 AM)
Firmware on 003A79A9 was updated to Z-013-F (8:53 AM)
Firmware on 003A787E was updated to Z-013-F (8:51 AM)
Firmware on 003A7875 was updated to Z-013-F (8:49 AM)
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2. The Setup tab should automatically load with the Location section expanded

Setup Updates Databases Plugins

-~
" For sunrise/sunset (astronomical time —
offzets]):
Gateway 000003FC ’
Gateway 004488BA Zhoose nearest location:
B Country:
Time Zone and DST as: Us |E|
America/New York |E| State: 3
Connecticut |E|
City:
Mew Haven |E|
Latitude Morth Longitude East
(Degrees, Minutes) (Degrees, Minutes)
] . . ‘-

Gateway Password

Gateways

Mail Server

3. Click the Server or Gateway you wish to edit

BensorView Semver -

Gateway 000003FC
Gateway 004488BA

Time Fone and DST as:
America/Mew York |Z|
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4. Uncheck the Edit Coordinates box to edit the Country/State/City fields

For sunriz=/suns=t {astronomical time offs=ts):

5. Click Save to apply your changes
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View Device Properties

1. Click the Devices tab

Log Out (adminestrator)

P W e e W e W e W
. g ! onltro | roup w )
! S— ! ! | ! ! ) = !
anHT sensorview | DoV'e®s | | Channels Settings | | Profiles | Do e | B
—

Overview

Recent Activity

Firmware on 003A7988 was updated to Z-013-F
(10/17/2012)

Firmware on 003A79A9 was updated to Z-013-F
(10/17/2012)
Firmware on 003A787E was updated to Z-013-F
(10/17/2012)
Firmware on 003A7875 was updated to 13-F
(10/17/2012)
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2. Using the nLight Network tree to the left, find the device you wish to view

Admin Green Screen Log Overview

Log Out (administrator)
) “Control " (" Group
nLlGHT SENSORVIEW Channels Settings
nUghtNetworl( Properties BTN SEEIINTTS

Profiles Schedules Users

Dedault Sattings

Find devices

GZ

Gateway
Series 2

nGWY2
Gateway 2: CPU Unit

| Refresh network. | (.. - Rediscover |

¥ Basic info

ID: 004488BA
Firmware Version: F235C001_1.2.32818 / F235C002_2.6.30.1

Label: |Training Room |
Notes:
P

» Advanced details
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3. Click the desired device; the properties will populate the Devices area to the right

Admin Green Screen Log Overview Log Out (administrator)
L~ I —— _—
: Conteor Profil Schedules U
- rores 1 ule sSers
NLIGHT sensorview Channels

nLight Network

:occupancy
=y = Thursday, October 18, 2012
9 noon 3 6 9 12

nCM PDT S
Standard Range 360° Sensor - Ceiling Mount, Low
Voltage, Dual Technology (PDT)

(Restore factory settings) Rediscov 7|

¥ Basic info

Device ID: 00000352
Firmware Version: F183E004Z-003 / F183E002E
Label: |nCM-PDT-9

Notes:

» Advanced details

» Health

4. Change the Label, Notes, and other areas to your requirements

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 34 of 123



<AcuityControls.

nLight. .
SensorView Manual

5. Click Save to apply your changes

¥ Basic info

Dewvice ID: 00000352
Firmware Version: F183E004Z-003 / F183E002E

Label: |nCM-PDT-9 |

Notes: | Third from the window]

Save
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ViEWing / Editing Normal Device SettingS: Sensors/WallPods/Power Packs

1. Click the Devices tab

Log Out (adminsstrator)

( ) Control [ Group O A £ A £ \

- - ) > ! |
I Devices ‘ I{ Channels | | Settings " Profiles ’ _‘S(hedulcsr : Users |
e —

nGZiHT SENSORVIEW

Overview

Recent Activity

Firmware on 003A7988 was updated to Z-013-F
(10/17/2012)

Firmware on 003A79A9 was updated to Z-013-F
(10/17/2012)
Firmware on 003A787E was updated to Z-013-F
(10/17/2012)
Firmware on 003A7875 was updated to Z-013-F
(10/17/2012)

2. Using the Device tree to the left, find the device you wish to view
nLight Network

I ‘accupancy I >

¥ Training Room
¥ Back Bridge

» Lobby
¥ Lunch Area

nCM-FDT, By Bathroom
nCM-FDOT, By Kitchen
¥ Supply Closet
nCM PDT 9 (00000DAS)
3. Click the desired device

nLight Network

I ‘occupancy I >

¥ Training Room -
¥ Back Bridge
¥ Lobby
¥ Lunch Area
nCM-FDT, By Bathroom
nCM-POT, By Kitchen
¥ Supply Closet
nCM PDT 9 (00000DAS)
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4. Click the Current Settings tab (if it’s grayed out, settings aren’t applicable to the current
selection, & you need to pick another device)
Properties Eoill5LL RS G (G LER Default Settings | Status

Apply Settings Revert to Defaults nCM-PDT-9 (nCM PDT 9) [Zone

— Owverride & Time Delay

Time Delay:

10 min |E|

— Broadcasting

Omupa.t::y Erua(k:a.uﬂ.uﬁ:
Enabled |E|
LED: Microphonics:
Mormal |Z| Mormal |E|
Microphone Crace Period: 100 Hour Burn In:

10 sec [=] |Disabled (=]

5. Your device’s specific settings (varies from device to device) will show
6. Modify the settings in the dropdown/checkbox fields to your specifications (You may also
revert to device defaults by clicking the button at the top)

Properties STy gliig1= 1]l
Apply Settings Revert to Defaults

Owverride & Time Delay
Time Dda}r:

10 min |E|

7. After you’ve made your changes, click the Apply Settings button to save your modifications
Properties Ry olig = ailiTii

Revert to Defaults

Apply Settings

Owerride & Time Delay

Time Delay:

10 min |Z|

Note: hovering over a setting will cause its definition to appear in the information pane at the
bottom of the page. The SensorView Terms Glossary also lists these definitions.

ime Delay: The length of time an cccupancy sensor will keep the lights on after it last detects cccupancy
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Viewing / Editing Scene Selector / nlO Settings:

1. Click the Devices tab

( \ (" Control [ Group

-
x ices™ | AT
nG—éHT SENSORVIEW | Daesas | | Channels Settings
—

Overview

Recent Activity

Firmware on 003A7988 was updated to Z-013-F

(10/17/2012)
Firmware on 003A79A9 was updated to Z-013-F
(10/17/2012)
Firmware on 003A787E was updated to Z-013-F
(10/17/2012)
Firmware on 003A7875 was updated to Z-013-F
(10/17/2012)

2. Using the nLight Network tree to the left, find a Scene Selector or nlO
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3. Click the desired device

D

Control i.rr'nnxlx

.
nLlGHT SENSORVIEW Channels Settings Profiles

Properties

Thursday, October 18, 2012
do 9 3

Ismumm 141

|
nio
Universal Input/Output/Oimming Device

vice control - Pole 1
(<1 - Bt -1 -}

¥ Basic info

Device ID: 00005752
Firmware Version: F2278001Z-011 / F2278002F
Label: [niO, Row 4, Left
Notes:

5N

(Save)

p» Advanced details

» Health
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4. Click the Current Settings tab (if it’s grayed out, settings aren’t applicable, & you need to pick

Carrent Settingsl |

another device)

<« Thuraday, October 15, 012
12 3 6 9 noon 3

Reslote factory settngs | Hodacover

5. For Scene Selectors, the currently assigned action for each of the four control mode buttons is
displayed. Change settings for each button via the dropdowns. Click Apply Settings to save.
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|Pru|:|erties Wl Rt ai el Default Settings | S

Apply Settings

Revertto Defaults

nl0, Row 4, Left (nI0)

—Owverride & Time Delay
Ohvearrides

Mormal

—Broadcasting

Switch Broadcasting:
| Enabled =]
—Tracking
Tracking: Special Switch Tracking Mode
|Se|ect Type(s) | MNormal El
—Photocell
Follow Photocd]l Mode
| Disabled =
—Dimming
Dimming Range (High): Dimming Range (Low):
1 100% =] [10% B
Dimming Raw= Idle Time Uil Dim:
|N|:|rrnal El |T.5 min El
Infinite Dimming Time Dday: WallPod Dimming Adjustments:
| Disabled El | Permanent El
—Special Modes
Special Modes:
|N|:|rmal El
—Sweep
Swerp Exit Time Swerp Grace Paiod:
| 15 sec El | b sec El
LED: Absolute Lower DHm Limix
|N|:|rmal El |[]1-,.r El
Dl Zone Offsct: Button Mode=
| 0% [=] |Disabled (=]
100 Hour Burn In: nlO Tnput:
| Disabled [=] |Disabled =]
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Control Mode Options (triggered through a button push or nlO input event):
Scene Control — Initiates corresponding scene outlined in Default Settings
Wallpod — On/Off functionality for the associated lights

Sweep — Initiates sweep for the corresponding number in Default Settings
Disabled — Disables the corresponding button

To create Scene Selector / nlO Scenes & Profiles:

1. Click the Devices tab

L Out (adminestrator

Cont £=6 \

. ( . ((.Con rol ) i roup ) f W \ £ \
nG;HT SEUCORVIW ‘! Devices | | Channels Settings | Profiles | Schedules | | Users |
e

Overview

Recent Activity

Firmware on 003A7988 was updated to Z-013-F
(10/17/2012)

Firmware on 003A79A9 was updated to Z-013-F
(10/17/2012)
Firmware on 003A787E was updated to Z-013-F
(10/17/2012)
Firmware on 003A7875 was updated to Z-013-F
(10/17/2012)

2. Using the nLight Network tree to the left, find a Scene Selector or nlO
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3. Click the desired device

D

Control i.rr'nnxlx

.
nLlGHT SENSORVIEW Channels Settings Profiles

Properties

Thursday, October 18, 2012
do 9 3

Ismumm 141

|
nio
Universal Input/Output/Oimming Device

vice control - Pole 1
(<1 - Bt -1 -}

¥ Basic info

Device ID: 00005752
Firmware Version: F2278001Z-011 / F2278002F
Label: [niO, Row 4, Left
Notes:

5N

(Save)

p» Advanced details

» Health
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4. Click the Default Settings tab (if grayed out, settings aren’t applicable to the current choice, &

Current Settings IDEfau[t Settingsl Status

you need to pick a new device)

nl0, Row 4, Left (n10) [Zone

£ Thur=sday, October 18, 2042 Fee
12 3 6 9 Moon 3 6 9 12

TS UT S U LAY

nlQ
Universal Input/Output/Dimming Device

—Device control - Pole 1

G- RSt - T>)

| Restore factory settings | | Rediscover |

¥ Basic info

Dewvice ID: 00005752
Firmware Version: F227B001Z-011 f F227B002F
Label: |nIO, Row 4, Left !

Notes: |

(save]

p Advanced details

» Health

5. Select a button, type a name to associate with it, then select which mode you wish to run in:
Wallpod — Assigns on/off control to button
Scene — Assigns created scene to button
Profile — Assigns an existing profile to button
Sweep — Assigns sweep to selected button
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For buttons designated with Scene Mode:
Create a scene via the device settings & exceptions dropdowns.

Properties | Current Settings @ilo EI] S0 11T 13

Save Defaults Save Defaults and Apply Now P WH (0000AB11) (nPODS WH) [Zonel

vode: [Scene 5]
T
- .
All Devices Disabled
[ e paulstest |

| Add an exception

Dimming Range (High)
| All Devices 100%
Except nI0 Pendant [:] 50%

£1 [ E1 w1 1 {w

| Add an exception

| Add a setting E

— Sweep
Swerp Exit Time Swerp Crace Pariod:

1 sec E :5 SEC EI

r Expiration Time

Snul: 1: Scene 2:
Infinite |E| | Infinite EI
Scene 3: Scun: 4:
Infinite E [ 1 Hour E
Profile Override n{Jass:

'Disabled E Disabled E
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For buttons designated with Profile Mode:
Select an existing profile you wish to attach to the selected button.
Properties | Current Settings Q= ETETIIE

Save Defaults Save Defauits and Apply Now nPODS WH (0000AB11) (nPODS WH) [Zon

1: 100% Name: 100% Mode: |Profile E‘

2: 75% Profiles: | Scott Test 3

3: 50%

I 4: pauls test |

Sweep Exdit Time Sweep Crace Period:

1 sec E| b sec |E|

Expiration Time

Scene 1 Scerwe 1
Infinite E Infinite |E|
Score 3: Score 41
Infinite E| 1 Hour EI
Prafile hverri des n(Jass:

Disabled |E| Disabled E]

For buttons designated with Sweep Control Mode:

The Sweep Exit and Sweep Grace Period dropdowns allow you to set a time delay, after which
the value of the remaining time delay in all applicable devices will be changed to the input value.
This is helpful if you wish to quickly turn all the lights in a zone or building off without affecting
any of the device settings.
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Properties | Current Settings @elo FITHET i {1717

Save Defaults

Save Defaults and Apply Now nPODS WH (0000AB11) (nPO

vode: (Sueep )

3: 50%

4: pauls test

Sweep
Sweorp Fxit Time Swerp Grace Pariod:

1 sec E 5 sec E

Expiration Time

Scene 1: Scene 2:
Infinite E| Infinite E]
Scene % Scene 4:
Infinite E| 1 Hour
Profile Ovaride il Jass;
Disabled E Disabled E

6. Click Save Defaults and Apply Now to save, then click another number to change its settings.

I Save Defaults - Save Defaults and Apply Now I
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Viewing / Editing Zone Settings

1. Click the Group Settings tab

2. Using the nLight Network tree to the left, click the checkbox next to the desired Zone to select
all devices within the zone.
Note: Each port of a Bridge is considered a zone

3. Create the list of settings to be modified by selecting settings one at a time from the provided
dropdown field

4. To prevent a device from having a particular setting apply, create an exception

After you’ve made your changes, click the Save Defaults button to save your modifications

6. Referto the Appendix for specific details regarding each setting’s meaning

g

Managing Profiles

The Profiles page provides the ability to create, edit, and delete all Profiles configured within the
system. All Profiles displayed will be grouped with other Profiles sharing the same state: Synchronized,
Mismatched, SensorView Only, or Gateway Only.

While creating or editing a profile the Device tree will operate in MultiSelect mode, there is no limit on
how many devices can participate in a given Profile. As Devices are added to the Profile more settings
may become available on the right, settings are only displayed if there is a Device selected that contains
it, settings will be omitted if no Devices selected support it.

The Scheduler, visible at the bottom of the screen, controls the Schedule for the Profile. Profiles can be
configured to start/stop at a particular time of day, or based on an offset from Sunrise or

Sunset. Recurrences specify how often the Profile should recur in the future, available Recurrences are
Daily, Weekly, Monthly, and Yearly.

The Scheduler also contains a tab for Priority, which allows specification of how Scheduling conflicts
should be handled. If two, or more, Profiles’ execution times overlap then the Priority determines which
Profile will run on each Device. The Schedules section provides a view of exactly how Scheduling
conflicts will be resolved by Priority.

Create a Profile

Click the Profiles tab

Click on New

Profile will show up under the SensorView Only header

Select all Devices that should be in the Profile using the Device Tree, as Devices are added more
Settings will become available in the Settings area

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 48 of 123

PwnNE



<AcuityControls.

nlLight. .
SensorView Manual

5. Inthe Scheduler/Priority section, create a schedule with any required recurrences, then click
Create. For additional schedules select New Schedule in the dropdown and repeat the previous
process.

6. Click the Priority tab to modify the priority of the profile using the arrows. Priority will only
matter if another Profile is scheduled to execute at the same time, on the same Device.

7. Select desired settings to be added / modified by the profile from the Settings dropdowns;
choose values & pick exceptions, if needed.

8. Once all Settings and Schedules have been configured fill in the name for the profile and
click Save, the Profile will then move under the Synchronized header.

Edit a Profile

Click the Profiles tab

Select a Profile Name

Edit the schedule & priority, clicking Update to save your changes when finished

Remove any existing settings by clicking the — button, modify the current values, or use the Add
a Setting dropdown to add new ones

5. Repeat for each setting you wish to modify, then click Save

PWNPE

On Demand Profiles

SensorView provides the ability to command a Profile to Run or Stop on demand. This is often utilized
for standard events that don’t recur according to a specific Schedule, but requires the same lighting
configuration.

When a Profile is run on demand it will not stop according to any Schedule, it must be stopped
manually; other Profiles that are scheduled to run at the same time, or afterwards, will still execute
normally. When a Profile is stopped on demand, and it has a schedule, it will still follow the next
Recurrence of the Schedule.

To command a Profile manually:
1. Click the Profiles tab
2. Select a Profile Name
3. Click either Run or Stop to command the Profile

Delete a Profile

1. Click the Profiles tab
2. Select a Profile Name
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3. Click Delete to permanently remove that profile

A pop-up will confirm that you wish to do this. Click Ok.

5. Repeat for each profile you wish to delete
**Please note: deleted profiles are permanently removed. Be certain you wish to delete the
profile before proceeding.

E

View Reports

SensorView provides a variety of generated reports detailing all configurable aspects of the nLight
network. To view a list of available reports refer to SensorView Reports.
To Generate a Report:

Click the Admin link

Click the Reports tab

Select the report you wish to run. Click Generate Report

Once run, print a report using the Print Report button, supported browsers all provide the
option to Print to a PDF

PwNPE

Upgrading Devices

Click the Admin link in the top right

Click the Updates tab (or click the “Updates” link from the Overview page)
Check the selected items you wish to update (unchecked items will not update)
Click Submit at the bottom of the page

PwNPE

Downloading Firmware Cache:
Available when internet connection is present & an updated version of SensorView is available,
enabling update downloads that are made available to an offline network.

Note: This process may be lengthy depending on the size of the network.
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SensorView

Installing SensorView is a multi-step process that should only be completed by a qualified
computer administrator. Before proceeding, please make the following items available to
ensure a successful SensorView Installation:

e Windows Installation Disk (Required for Windows XP & Windows Server 2003)
e Active Internet Connection

e SensorView Registration Key (provided in each Gateway box)
e Cross wired CAT-5(e) cable (click here for pinouts)

nLIGHT il
GKBJ9. 25N ECR771
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Step 1: Requirements

There are two types of installations available for SensorView:

Single-User / Commissioning
For use with any nLight network where a single user operates or commissions the system.

'MINIMUM SPECS: SUGGESTED SPECS:
Software: Software:
IIS 6.0, .NET 4.5.1 IIS 8.0, .NET 4.5.1

Browser: Browser:
Firefox, Chrome, Opera, or Internet Explorer 10+ |Firefox, Chrome, Opera, or Internet Explorer 10+

Multi-User
For use with any nLight network where multiple concurrent web sessions are desired.

SUGGESTED SPECS:

MINIMUM SPECS:

Software: Software:
11S 6.0, .NET 4.5.1 11S 8.0, .NET 4.5.1
rBrowser: Browser:

Firefox, Chrome, Opera, or Internet Explorer 10+ Firefox, Chrome, Opera, or Internet Explorer 10+
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Step 2: Pre-Installation
SensorView requires pre-installation of both IIS and the Microsoft .NET Framework.

.NET Framework

The .NET Framework 3.0 is automatically installed with Windows Server 2008 & Windows Vista
/7 / 8. 1f you are NOT running either of these operating systems, click here and follow the .NET
installation instructions.

s

IS (Internet Information Services) is a Windows component that allows computers to host web
applications. This component is required for hosting a SensorView installation, and will allow
end users to view and control their SensorView install(s) remotely.

To install IIS, please click the link to your corresponding operating system below and follow the
specific information for installing this component.

Please Note: Both Win XP & Server 2003 require Windows installation disks and are NOT
downloadable from the web. Without Windows discs to install this component, SensorView
installation cannot be completed:

e Windows XP Pro (32 bit) — IS 5.0

e Windows Small Business Server 2003 (32 bit) — IIS 6.0
e Windows Server 2003 (32 bit) —11S 6.0

e Windows Server 2003 (64 bit) —11S 6.0

e Windows Server 2008 —1IS 7.0

e Windows Vista /7 / 8 — IS 7.0[pa3]
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Step 3: Installation
After completing the successful installation of 1IS (and .NET), you are now ready to continue:
Download the nLight SensorView installation package:

1. Download the compressed .zip file (20 mb) from:

2. Unzip the file and run setup.exe.
3. Follow the instructional prompts to complete the installation of the SensorView
application.

SensorView Installation Best Practices

It is recommended to do a full install of all offered features/plugins.

All boxes are checked by default. If they are not, please check them and click Next.

SensorView - InstallShield Wizard lﬂ

Select Features
Selectthe features setup will install. 8@@8@[}"“‘“‘h

Aneuityss

Selectthe features you want to install, and deselectthe features vou do not want to install.

=] i Description
nLight Commissioning Installs nLight Sensorview
~InLight Support software to configure and
~InLight Flugins maintain your nLight neteark.

878971.90 MB of space available on the C drive

T

SensorView will require registration to complete the installation process.

SensorView Registration
This includes a license key as well as information about who is installing
(the registration key is included on a small card with the gateway)

When the Install Shield wizard opens, select “Default Web Site” and click Next.
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-

SensorView - InstallShield Wizard

5=)

Site Information
Selectwhich\Weh Serveryou'd like Sensoryview SERSE itch
to be installed under. JPRPSTI————
Weh Sites Site Configuration:
Daf 5
Site Name: Default\Weh Site
| Assigned Port: B |
] Host Headers:
P Fort Header
(Al Unassign... 80
(Al Unassign...
a08 *
I localhost
localhost
InstallShield
cess || e ]

Click Install

| . .
SensorView - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation

===

A orpary

Click Install to begin installation.
wizard

InstallShield

If wou want to rewview or change any of your installation settings. click Back. Click Cancel to exitthe

|

Install

< Back ”

The install shield wizard takes a few moments to run.
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r— —
SensorView - InstallShield Wizard I - ‘M
Setup Status
seaserswitch

Ayt

The InstallShield Wizard is installing Sensorview

J Installing

G, A{13F9BARF-2426-41 26-9860-A3693D7 DEAEE S ensorview. msi

IngtallShield

Cancel

If you see the following message, click “install this driver software anyway”.

& Windows Security . —— _

® Windows can't verify the publisher of this driver software

<» Don't install this driver software

You should check your manufacturer's website for updated driver software for
your device,

< Install this driver software anyway
Only install driver software obtained from your manufacturer's website or disc.

Unsigned software from other sources may harm your computer or steal
information.

(v See details

The installation is complete. Click the box to launch SensorView, or
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SensorView - InstallShield Wizard I _ ‘

InstallShield Wizard Complete

The InstallShield ‘Wizard has successfully installed Sensorview
Click Finish to exit the wizard.

[iLaunch Sensorview Application:

g ’j
° /

“When Sensorview loads the default accountis
n‘-IGHT administratorfadmin. Flease ensure you change the password as
well as updating vour email information into the Administrator
account,

Click Start, All Programs, Select nLight SensorView

eReaders : ' ‘

Games

Google Chrome
Google Earth
HP Documents
HP Help and Support

Ipswitch WS_FTP 12 Pictures
LameACM

LightScribe Direct Disc Labeling
Maintenance

Music

. ) Games
Microsoft LifeCam

Microsoft Office

Microsoft Silverlight
nLight Control Panel
Q nLight Commissioning Tool
> nLight Network Debug Devices and Printers
0 nLight SensorView
@ nLight TechView Default Programs

| Norton Online Backup

Computer

Help and Support

4 Back

re—— r—
Search programs and files Shut down | »

Launch SensorView on the desktop.
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A username and password are required to login to SensorView. When SensorView is freshly
installed, use the following:

Default User Name: administrator
Default Password: admin

Login

User Name usemame

Password
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Step 4: Connecting to Gateway

The Gateway uses the port labeled “Ethernet” to communicate with the computer running the
SensorView software. There are several ways to connect to a gateway; please choose the
method you wish to use:

Direct Connection

The following procedure will show you how to establish a direct connection between a laptop
computer and a Gateway:

NOTE: a cross-wired CAT-5(e) cable is only required to connect this way to an nGWY1,
nGWY2 does not require a cross-wired cable

1.
2.

If present, disable wireless networking card
Connect PC to Gateway’s Ethernet port with cross-wired (cross-over) CAT-5(e) cable
NOTE: a standard patch cable (straight through wired) will not work
Turn off/verify DHCP on Gateway
MENU > SETUP OPTIONS > SET [DHCP OFF]
NOTE: if pin is required, enter 1234
Enter static IP address for Gateway (for example 192.168.1.2)
MENU > SETUP OPTIONS > TCP/IP
Enter static IP address for Laptop (e.g., 192.168.1.5). The following instructions are
for Windows XP. Other operating systems may require different procedures for
changing network address.

1. START > CONTROL PANEL > NETWORK CONNECTIONS > LOCAL

AREA CONNECTION > PROPERTIES

2. Highlight Internet Protocol (TCP/IP) in box and click Properties
Click the radio button for “Use the following IP address”

4. Fillin

IP address: 192.168.1.5
Subnet Mask: 255.255.255.0
Default Gateway: 192.168.1.1

5. Click OK
Verify “Link Up” message on Gateway LCD screen. If “Link Up” message does not
appear, reboot gateway
MENU > REBOOT
Launch SensorView
http://localhost/SensorView
Login to SensorView
Default User Name: administrator

Default Password: admin

w
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9. Once SensorView detects the Gateway it will appear in device tree
10. If Gateway does not appear in the tree, call tech support; 1.800.535.2465

LAN Connection

The following procedure will show you how to connect to a Gateway over an existing Ethernet
Local Area Network (LAN).

NOTE: if the computer and Gateway are located on different subnets, use the instructions
for connecting over a Wide Area Network (WAN).

Connect SensorView’s computer to LAN using a standard patch cable
Connect Gateway’s Ethernet port to LAN using a standard patch cable
If Link Up message appears on Gateway, go to step e, if not continue to next step
The Gateway can either use a dedicated IP address or acquire one from the
network’s DHCP server.
1. To enter a dedicated IP address:
1. Turn off DHCP on Gateway
MENU > SETUP OPTIONS > SET [DHCP OFF]
NOTE: if pin is required, enter 1234
2. Enter static IP address for Gateway (for example 192.168.1.2)
MENU > SETUP OPTIONS > TCP/IP
3. Return to main screen and verify “Link Up” message. If “Link Up”
message does not appear, reboot gateway
MENU > REBOOT
2. To use a DHCP assigned IP address:
1. Turn On / Verify DHCP on Gateway
MENU > SETUP OPTIONS > SET [DHCP ON]
NOTE: if pin is required, enter 1234
2. If DHCP fails, force the Gateway to acquire an address
MENU > GET IP ADDRESS
3. Return to main screen. Verify “Link Up” message
5. Launch SensorView
From host computer: http://localhost/SensorView
From non-host computer on LAN: http://[enter server name]/SensorView
6. Login to SensorView
Default User Name: administrator
Default Password: admin
7. Once SensorView discovers the Gateway it will appear in device tree
8. If Gateway does not appear in tree, call Sensor Switch tech support; 1.800.535.2465

PwnNPE
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nGWY2 CTRL

nGWY2 GFX
SENSORVIEW

-
-

Q000

WAN Connection

If you would like to connect to a Gateway over an existing Wide Area Network (WAN), please
call tech support at 1.800.535.2465.

Crossover Cable Reference
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Virtual WallPods

With the Virtual WallPod applications, users can control their lighting from their desktop or iOS
mobile device. Designed to look like WallPods®, these applications are an excellent alternative
to remote controls, which are often lost and require battery replacement. Simple user
permissions provide facility managers necessary administrative control.

Configuring SensorView

SensorView is a required component of the Virtual WallPods Plugin. It is used to setup and
configure Users and the Virtual WallPods associated with them; as well as authenticate and
process commands sent by Virtual WallPods.

Use of Virtual WallPods requires SensorView be online and accessible.
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Update SensorView

Step 1

\Before\[DAz;] starting, log into your SensorView page and click on Admin at the top right of the
screen.
If you see a Plugins tab, skip Step 1 and proceed to Start the nLight Virtual WallPod Server.

“ stra
.
nfl?il'lT SENSORVIEW Foewces | oroune | praties . achedutes

Updates Databases Flugins

Manage Users

Location

You may edit your lacation in one of two ways. If

Sensorvisw Senver a Horth Longitude West the "Edit Coordinates® bos is checked, input your
..... ety BOLAGT1 Degrass, Minuts (Dsgrees, Miraites) location via the latitude and longitude boxkes an
[E2 |EX 1149 7 ] the right. If the “Edit Coordinates® bas: is

unchecked, you may edt your location through

L [ Edit Cooedinats the dropdawns below.
el 06 st loc
. Coun This enables you to change your current gateway
1ot password

New gateways can be discovered by 1P, and
eisting gateways can be deleted or exchuded.

Update the settings here so that lost passwords
and other system update information can be
accurately sent to you

Gateway Password

Gateways

Mail Server

If you do not see a Plugins tab, click the Updates tab and update to the latest version of
SensorView. Once the SensorView application update is finished, run the install file for
SensorView and select Modify.

SensorView)-nstallsieldWizand (% |SensorView:- InstallShield Wizard| Eﬂi

‘Welcome Select Features

Modify, repair, or remove the program S@mg@ﬁ‘mit‘h Select the features setup will install. S@Gﬂg@ﬁ‘mitch
A AUy Company A AUy oty

‘Welcome ta the Sensoryiew Setup Maintenance program. This program lets you modify the Select the features you want to install, and deselect the features you want to uninstall
current installation, Click one of the options below,

Description

@ Madify
. w] nLight Cormissioning Installs nLight Sensoryizw
@ Select new program features to add or select curently installed features to o rLight Suppart e ey
TEMOvE. rLight Plugine maintain your nLight network.
() Repair

@ Reinztall all program features installed by the previous setup.

O Bemave

B
Femove all installed features
39855.72 MB of space avalable on the C drive

< Back Mewt > ] [ Cancel ¢ Back ]
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Click Next, and once the proceeding page opens check the nLight Plugins box, followed
by Next.

Once the below screen appears the modification is complete, click Finish to close.

sensorVIEwW S nEtal Sl Wizar| . ‘

Maintenance Complete

InstallS hield \Wizard has finished performing maintenance
operations on Sensaryiew,

ntiGHT

Cancel < Back

Virtual WallPod Server
Step 2

Once at the Admin Dashboard, click Plugins and Start the nLight Virtual WallPod Server.

-
CioHT
NLIGHT sensorview

Manage Lsers Updates Dafabases

ik nlight Plug L | g and
SLOPPING @ Servics regquines admiriciratie acces
T Ehis SEfmoryies Sarer.

ALight Wirual Walpod Serser

Notice that stopped will change to running.
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-
nfl?iHT SENSORVIEW —— ) ey

Manege Lors Lipdates Pluging

Sarvices

Configure which Sensoriew plagine run. Green
Soreen and BACNEE plugins reguire the nLight

Stant Flugn HMost Service. To update plugns first stop
the muight Phagin Host Service, Startng snd
SLOPENG & Ervice regquires adminkirative access
13 e SEPEOrEw Seeer.

Virtual Controls

Step 3

Now that the nLight Virtual WallPod Server is running, go to the device page by clicking
the Devices tab at the top right area of the screen. Once the devices page opens, click on
the Virtual Devices tab, located in the same area.

nﬁ:ﬁHT SENSORVIEW

e
Lroups Frofiles Schedules

nLight Network Devicas Froperties

ey Model Hame: nGW
¥ nTXVA 250 (00008811) ik ODOREILT
= Gi Bl Portl 1P 13p.068) 6T
nTHYR 250 (D000BIER) Device Couwls W) @ DB 8 OFfine: @
¥ Groups Disce ® Cretails
All Devices Description: Gateway w nseriew Softwar b
Date Code: 0510
Firmmare Werslon FL34D001Z-002 / FL34D002E
Label: | Gateway - -
User Comments: | ]
s
Heset
| Ruizzavn

Select a user by clicking on the dropdown arrow
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ALAGhE Matwork Wirlwal Davices

¥ Cabaaay
* nTHVR ZE0 (0000BRIL]
= 51 Bl Fortl
nTHVR 250 (0O00BIER]
¥ Foups
Al Devices

Virtual WallPod Switch

Step 4

Click the Add a switch button.

nlight Netwark Wirtual Davices
v Gabamay —
¥ nTHVE T (DO0MIL1) =
* &1 B1 Partl
T 25D (DOO0BSER)
¥ Grouss
Al Devicas Kaw Suizh

Control Zone

Step 5

Select a zone (bridge port) to control, as well as an individual device or switch broadcasting
channel. For convenience, only the switch channels that devices are tracking within the zone

will appear in the channel dropdown menu.
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This screen shows the nLight Virtual WallPod controlling all devices connected to the zone that

are tracking switch via Channel 1 (A).

To control an individual device, select “Individual Device” from the Control Type dropdown (B).

To label the nLight Virtual WallPod, highlight the Switch Label box and enter the preferred

Switch Label (C).

If the nLight Virtual WallPod is to control dimming or a 2-Pole device, check the appropriate

box (D).

Wirtual Davices

gkt Metwork

W Galaray 7
¥ STHUR 250 (300009121 = ERedd
51 Bl Portl
ATHUR 250 (SOMIBRER]
¥ Groups
FA R T T 31 Bl Poetl CL
| A
B (e
nCHHE POT 10 (DDEERS )
0 {BODBABSA)
nPDA W [ D00sECS)
mEPS D (0004585
WSD FDT WH {SSDOATEE)
F.ndn-im-E

-.'ﬁ
I'IG; HT sensorview

nLight Motwork

Wirtual Davices

w et ay
¥ nTAVE TE0 (SO00AELL)
* G Bl Pord
TSR 250 (S0DIBAES)
v Graups
Al D o5

_Fisal nem shole o ]

APCOR WH
[I0IAECa)

Bl dewice ta controk

i
nPOEE WH [N008%ECS)
FisEs [ < E-2 5k
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Virtual WallPod Application

Download the Virtual WallPod application from the Overview page of SensorView. Click the
Overview tab at the top right portion of the screen, then Virtual WallPod under the Downloads
section (bottom right) to download.

Note: The download link will only be shown if the Virtual WallPod Plugin has been enabled.

)

.
NLIGHT sensorview T e P T

Devices

Overvdaw

Recent Activity

Device Network

Updates

|Show Au|

Downloads

Opening VWPGLentInstallerc1kdk 364 BB2052ip ﬂi

‘ou have chosen ko open

Q ¥WPClientInstaller-1.1.36.18820.zip
which is a: WinZip File
From: http:/flocalhost

‘What should Firefox do with Ehis file?

) Openwith | WinZip (default) D

(%) Save File |

[] Da this automatically For Files like this Fram now on,

I ]9 l ’ Cancel ]

It is recommended to save this file to a flash drive so that it can be installed to other machines
throughout the network.

Once the files have been downloaded and extracted to a folder, locate it and run setup.exe
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= setup EIEIx]
File Edit ‘Wew Favorites Tools  Help 1','
- ) @) >
@ Back, </ l.ﬁ 7 Search i Folders
Address |[C3) CriDacuments and Sethings\ris03\DesktopinLightiSensar Yiew Setupiiew FolderiSetup D Go
Setup,dl p datal
File and Folder Tasks E T‘I.D.g. 162 g_‘l : WinZin File
FLE%net (R InstallShield (RY S... TI0KE
Iim Renare this file
[y Mave this File dakal.hdr _ dakaz
' o HOR. Fils =¥ winzipFls
Capy this File v : 455 K
&N Publish this file ta the Web
(5] E-mail this File IsSetup.di layout
o 14.0,0.162 EIM File
XK Delete this fil= Instalshield (R} Setup Engine 1KE
setup
Other Places 3 Configuration Settings
1 KB
() Mew Folder
setup Description: Setup.exe
My Documents I File Companty: Macrovision Corporation
:e My Computer 299 KB File Yersion: 14.0.0.162
- Dake Created: Si4/2011 12:52 PM
i:g Iy Mebwork Places Size: 64 KB
Details ¥

Next, follow the setup file’s installation steps.

el Wl L nliGiatd e [5¢] WirtuaiWalPaaEstallshield Wi and X]|

SRS itch Choose Destination Location SRS itch
| ErSWI | Select folder where setup will nstall files | OrSW |

AnSAcultyiands Compiry AnAcultySands Compary
Welcome to the Virtual WallPod installation Setup will install Virtual WallPod in the follawing foldsr

wizard
Ta irstall ton this folder, click Next Tainstall to a different folder, click Browse and selact
anather folder,

The InstallShisld Wizard will install Yirtusl WalPod an pour
computer. To continue, click Next

D
nLiGHT

Destinatian Foldzr

C:A\Program Files\SensarSwitch

Coo ]

-y

varipe Wl [Hod Bainstallsiheld Wi zard| a vintpalSalBod Sinstallvhrel d Wizarnd|

Ready to Install Virtual WallPod
| seqserswitch |

ArAcuy:

InstallS hield Wizard Complete

- 5 The InstallShield Wizard has successfully installed Virtual
Click Instal ta begin installation “wallPad. Click Finish to exit the wizard,
1 piou) want to review or change any of your installation settings, click Back. Click Cancel to exit
the wizard

nLiGHT

Cancel < Back

Cancel |
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Once the install is complete, follow the path.
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0 =me

0 topeh

) Dres Trstarvs VPN Chare
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Show AN

Downloads
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Start/All Programs/nLight/nLight Virtual WallPod. (above)
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.
ﬂGéHT SENSORVIEW [ooTnieerT] [ereuee] [Trrenice] [Sihequrer) [FrEvwm=

Devices

Device Network
» Al Devices

Offline Devices

Updates
[Show Al |

Misread Devices

Devices Requiring Updates

Downloads

 nlight Docurnentation
* Virtual Walkes

[ teworcoboron |
Rafresh Virtusl WalPods

flun O

o
[
#] t T

AL A @ T (e roodtoee. <] @aasyigwsson. | @rigtsemmben .|

N A8 @ATIT RS By 1110m

Once the icon for the nLight Virtual WallPod appears in the Taskbar, right-click it and enter the
network configuration.

| Metwaork Configuration

Refresh Yirtual WalPods

Fun On Skartup

About

FECde AT AD Big, 10w

All fields are required for configuration

S SR hittp: //localhost/sensorview

Sensoriew User: [IENY

Cancel
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If the nLight Virtual WallPod app is installed to the SensorView host machine, the SensorView
URL will match the (left) screenshot.

If it is installed to a remote machine (that is on the same LAN or subnet) the SensorView URL
will be: http://[host name or IP address]/sensorview
Login as a user assigned one or more Virtual WallPods in SensorView.

The nLight Virtual WallPod is now running and will control the assigned relays.

| Ryan's Office

Now that setup for the host machine is complete, the iOS app can be downloaded and installed.

Virtual WallPod iOS App

This section details how to install and setup the Virtual WallPod software for iOS devices.
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Download and Install iOS application

e 3¢ 7:04 AM 3 90% =t

The nLight Virtual WallPod is an application made
available exclusively to owners of an nLight
Lighting Control System by Acuity Brands.

This application provides onscreen (i.e. virtual)
WallPod on/off and dimming controls that enable
users to remotely operate nLight networked
lighting loads over Wi-Fi or 3G.

Features:

- WallPod control icons function as on/off switches
or dimmers

- For zone control each WallPod communicates to
all devices listening on one of sixteen channels

- For individual device control each WallPod
communicates to a specific nLight device

- A WallPod can be specified as a favorite and,
upon login, will be displayed instead of the Devices

Go to the App Store on the device that will have the nLight Virtual WallPod installed.

Search for nLight Virtual WallPod.

Note that the App is free of charge, as is all nLight software.

Click FREE, followed by the green INSTALL button that appears.

(note: an iTunes account is required)

[ 7:05 AM 3 90% b

Info

Once installed, click the WallPod App icon to launch.
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. 7:06 AM R 89% =t

Wall Pod Settings | pone

Server Settings

URL http://yourserver/sensorview

h y

Login Settings

/ N
Save Username m
Save Password OFF
Auto Logon OFF
Use WiFi Connection

General Information
o N
Version 1.0.0

. A4

The app will open the WallPod Settings page the first time it’s launched.
Enter the Server Settings URL (replace “yourserver” with host machine’s IP address).

Set Save Password
and Auto Logon to desired settings.

Click Done.
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s 2 7:18 AM 3 88% b

o
nG?iHT'

Version: 1.0.0

a|w|e|R|T|v]u|i]o]P]

10:24 AM % 6%
ODOOOANN - o
— — e

-| Lobb >
clz|xfclvis|njufly
Ryan's Office >

Login with the user credentials for the nLight Virtual WallPod you wish to control. (left)

Select a switch from the devices list. (right)

Installation is now complete.

7:19 AM B 88% =
Ryan's Office

ON

Notice that the switch is backlit, indicating that the relay controlled by this nLight Virtual
WallPod is closed, i.e., “turned on.”
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Green Screen

This SensorView module logs and analyzes system and building performance. A “Savings
Scorecard” calculates energy savings in kWH or dollars.

As with SensorView itself, installing the GreenScreen plug-in should be performed by
authorized network administrators.

This will entail installing and setting up a database (PostgreSQL), a driver to connect to the
database, a DSN for the data source, initializing the database, starting GreenScreen, and
configuring GreenScreen options in SensorView.

Setting up PostgresQL

Setting up PostgreSQL on a computer requires downloading and installing the application,
configuring the database to accept remote connections, and restarting the database server.

e PostgreSQL is a separate product that is maintained and developed entirely
separate from SensorView and is in no way affiliated with nLight, SensorSwitch, or
Acuity Brands.

e For the remainder of this document the phrase “X.Y” will refer to major and
minor versions of the version of PostgreSQL being installed; for example: 9.0, 8.4.

e GreenScreen is compatible with PostgreSQL versions 8.4 or higher (9.0 recommended).

1.1: Installing PostgreSQL

SensorView can use an existing PostgreSQL database or a dedicated one. Which option is most
appropriate is at the discretion of the system owner. Download the most recent version for
either Windows x86-64 (64 bit) or x86-32 (32-bit). A few notes on the installer:

Super-User Creation Screen:
The screen below configures the default super-user account for PostgreSQL, take note of these
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credentials as those will be the default login account and password for the
PostgreSQL database.

Port Configuration Screen:

The screen below allows for configuration of the port that PostgreSQL will use for
connections. Use whatever value is required by system administrator. Note, SensorView and
GreenScreen can be configured to use any port value.

Advanced Options:

The screen below allows for configuration of the locale that PostgreSQL is operating in. The
default is almost always sufficient. If the installation site has specific requirements then

select the most appropriate option from the drop down. The selected option does not seriously
affect GreenScreen operations.

On the final screen, push “Next” to finish the installation of PostgreSQL onto the local
computer.

1.2: Allowing Remote Connections

This step is only necessary if SensorView and the PostgreSQL database reside on separate
computers. By default, PostgreSQL will not allow any remote connections; to change

this, administrative access to the host machine for the database is required. To setup
PostgreSQL to allow remote connections, go to the directory PostgreSQL was installed at (by
default C:\Program Files\PostgreSQL), from that folder open the file at X.Y\data\pg_hba.conf;
this file can be opened in notepad or any generic text editor. For how to configure pg_hba.conf,
as well as any questions, refer to: 8.4 documentation, 9.0 documentation

For all database versions, adding the following line to the bottom of the file to allow ALL remote
connections to the database:

host all 0.0.0.0/0 md5

Note, allowing all connections is a potential security risk that should be weighed by
system owners.

Save the changes and close the file. PostgreSQL will now accept remote connections from the
configured host.

1.3: Tuning PostgreSQL (Optional)

By default PostgreSQL is tuned for systems with low memory sets. By changing a few
configuration parameters GreenScreen database queries can be significantly sped up. To
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change configuration options go to the directory in which PostgreSQL was installed (by default
C:\Program Files\PostgreSQL). From that folder open the file X.Y\data\postgresql.conf with
notepad or any generic text editor. Note that some of the following setting recommendations
are based on the total system RAM available. Before entering the new values look up how
much total RAM is installed in the computer (right click on My Computer and select Properties)
and convert that value to MB (note that 1GB = 1024 MB).

The following changes are suggested to improve performance (note that leaving a # in front of a
line denotes a comment and the value will be ignored; remove any leading # for the setting to
take effect.

shared_buffers
Set to 25% of system RAM (not exceeding 512MB (256MB recommended for most installs)
default is 32MB

effective_cache_size
50-75% total RAM (in MB)
default is 128MB

After making changes to the configuration the PostgreSQL service must be restarted
(1.4) before the new settings will take effect.

Note: Overall system performance may vary. Modifying values may have a result on overall
system performance and stability, if problems persist revert modified settings to original values.

Sensor Switch is not responsible for any non-SensorView issues this may cause. Additional
tuning considerations.

1.4: Restarting PostgreSQL

PostgreSQL must be restarted before the changes made to pg_hba.conf will take effect. If

no changes were made to pg_hba.conf then this step is unnecessary. Go to Start Menu ->
Control Panel -> Administrative Tools -> Services (Windows XP / Server 2003) or Start Menu ->
Control Panel -> System and Security -> Administrative Tools -> Services (Windows Vista / 7 /
Server 2008).

In the services window select the following service:

8.4
PostgreSQL Server 8.4
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9.0
(32 bit) postgresql-9.0-PostgreSQL Server 9.0

9.0
(64 bit) Postgresql-x64-9.0

Right click on the relevant service name and select Restart; this will restart the database server.

1.5: Firewall Setup

If the computer running PostgreSQL is a different from the computer running SensorView, then
the firewall on the computer running PostgreSQL may need to be updated to allow for incoming
connections on whichever port PostgreSQL was configured to listen on. This will vary depending
on the firewall software in use.
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Setting Up Database Connection

A connection to the database that GreenScreen will store data in must be configured.

This involves downloading and installing a driver for the database and configuring a system DSN
that specifies the connection parameters to SensorView and GreenScreen. Both steps 2.1 and
2.2 must be performed on the computer that is running SensorView.

2.1: Installing a PostgreSQL Driver

For SensorView to connect and control the PostgreSQL database a driver must be installed on
the machine hosting SensorView. Download the Windows driver (x32 and x64).
After downloading open the zip file, run psglodbc.msi, and install the driver.

2.2: DSN Configuration

DSNs provide a way to configure a datasource connection in a standard consistent way that can
be used throughout the machine. A DSN must be configured to allow SensorView

and GreenScreen to connect to the database; this must be done on the machine

running SensorView. A DSN consists of a name, database, server, port, user, password, and

SSL connection requirements. Locating the correct DSN configuration tool varies depending on
the specific version of Windows and whether or not it is 64 bit.

e To configure a DSN for Windows XP 32 bit / Server 2003 bit go to:
Start Menu -> Control Panel -> Administrative Tools -> Data Sources (ODBC)
e To configure a DSN for all 64 bit variants of Windows go to:
Start Menu -> Run -> type C:\Windows\SysWOW64\odbcad32.exe and press
Enter (Assuming Windows is installed to C:, otherwise substitute correct system path)
e To configure a DSN for Windows Vista 32 bit / 7 32 bit / Server 2008 32 bit go to:
Start Menu -> Control Panel -> System and Security -> Administrative Tools -> Data
Sources (ODBC)

Once the Data Sources (ODBC) popup is open, select the tab System DSN, then press Add.
Select a datasource from the list. The name of the driver will vary depending on what was
installed, commonly for 32 bit the name will be “PostgreSQL Unicode”, this is the driver that
was previously installed during PostgreSQL setup (2.1). Select Finish and a form will appear with
additional fields to fill out.

Fill out the form with the following values:

e Data Source: A custom name for the DSN that will be put into SensorView
e Database: nlight_system_data
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e Server: IP Address or hostname of machine running PostgreSQL server. (127.0.0.1 or
localhost for local computer)

e Port: Port PostgreSQL was configured to run on (by default 5432)
User name Account name for the database user

e Password: Account password for the database user

e SSL Mode: As appropriate for the database (disabled by default)

Select Save. Note, the Data Source name value as this is the field that must be entered

into SensorView later. Note that pressing the Test button will fail with “database not found”
until step 3.1 has been completed. For testing purposes you can change the datasource name
to read ‘postgres’, and then test, if the connection is successful then change the datasource
parameter back to nlight_system_data, otherwise check the other parameters that were
entered.
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Setting Up GreenScreen

In order to configure and run SensorView the plug-ins component must be installed. For new
installs this can be accomplished by making sure that plug-ins is checked during the feature
select portion of the SensorView install. For existing installations, run the installer and select
Modify, then check plug-ins and push modify. Once the plug-in components have

been installed, open SensorView and go to the Admin page and select Plug-ins.

3.1: Administrator Email (Recommended)

GreenScreen will notify the administrator via email if it encounters any issues while attempting
to start. To configure email notification the administrator use of SensorView must have an
email address entered; additionally the Mail Server section (found at Admin >Setup-

>Mail Server) must be filled out to allow for email to be sent from SensorView. Notification
emails will be sent in two specific instances, if the host Windows service crashes (and the
subsequent automatic restart fails); or if, while starting up, GreenScreen is unable to start due
to version requirements, improper configuration, or any unexpected error.

3.2: Database Initialization

Once PostgreSQL, the database driver, and the system DSN have been set up and

configured, the last step is to build the GreenScreen database and start the service. To build the
database, in SensorView, go to Admin -> Databases. At the bottom of the screen is the
GreenScreen Database Setup section. Input the name of the custom DSN that was previously
configured and SensorView will build the database (upon hitting save). If the credentials
supplied in the DSN do not have the create database privilege, then SensorView will prompt for
credentials that do. SensorView will use those credentials to create the database and give
ownership to the credentials in the DSN. Afterwards the other, higher, set of credentials will be
discarded.

3.3: Starting GreenScreen

In order to start GreenScreen, the plug-ins component must have previously been installed
(3.0); if this has not been done then there will be no Plug-ins tab. Proceed to the Admin screen
in SensorView and select Plug-ins. The host service should already be running; if it is not then
the username, password, and domain (optional) must be filled out, then start the nLight Plug-in
Host Service. Once this is running GreenScreen can be started and stopped in the top window.
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3.4: GreenScreen Operations

Within the accordion select GreenScreen; on this page options can be set that will configure
how GreenScreen will compute savings and what units to display them in. Note that displaying
savings in dollars requires electrical generation rate information be entered on the Admin-
>Plugins->GreenScreen section.

Display Options:
SensorView can be configured to show savings in dollars or kWh. For CO2 savings, the
generation type for the electricity can be selected that will be used to determine CO2 savings.

Electrical Rates:

SensorView can be configured with the building’s electrical rates. Set the rate and time periods
in which the rate applies. These settings will only be used if SensorView is set to display savings
in dollars.

Baseline Periods:

During these periods, SensorView will assume the building is occupied. Energy savings
(whether in dollars or kWh) are relative to how much energy would have been spent, with
all control points in the system being on for the duration of the baseline periods. Refer to
the GreenScreen data sheet for a more detailed explanation of savings analysis.

Hit Save Settings to save the configuration.
Once SensorView has a valid Data Source which can connect to the database, it will display

the current size of the database and the state of hosting service in the bottom left corner of
the screen (completed in step 3.1).
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SensorView Page Mapping
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Admin  Green Screen

Overview

Recent Activity

« Firmware on 0042EA94 was updated to Z-009-E (6/29/2012)
« Firmware on 0042EA96 was updated to Z-009-E (6/29/2012)
* Firmware on 0042EA75 was updated to Z-0 E (6/29/2012)
« Firmware on 0042EA73 was updated to Z-009-E (6/29/2012)

Device Network

» All Devices 145
Offline Devices 1
Devices with Errors o

Devices with Warnings 0

SensorView Manual

Devices

® 3 Sen:

\ T prm—
(TGontrol ) Group )

| Channels | | Settings |

Updates

1 SensorView (7.3.142.30830)
w Plugins (4.0.4933.29622)
770)

1 Gateways

* 7 Bridges (Z-007)

1 Wallpods (Z-003)
4 Other (Y)

Downloads

nLight Documentation
Virtual Wallpod

Log Out (scottl

\ AT em—
Profiles ‘ [SchedulesJ { Users ‘

m

A successful login opens the Overview page,

e alist of all recent activity, including Firmware updates (upper left)
e a Device Network report showing a count of offline and total devices (lower left)

showing:

e alist of all current updates available, with direct links to download and install them. (lower

right)
o Upper left

o Admin allows authorized administrators to setup and configure SensorView and

perform updates.

o Green Screen (upper left) provides a historical and real-time status on energy savings
resulting from your installed nLight systems. For in-depth info: Green Screen.
Log displays troubleshooting data.

o Overview returns users to the Overview Screen.

The Overview page features four clickable tabs along the top.

e
Control

‘ [ Profiles Schedules ]

Channels

Log Out (quest)
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Find devices

Training R

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 86 of 123



<AcuityControls.

nLight. .
SensorView Manual

Green Screen

This SensorView GreenScreen module logs and analyzes system and building performance. A “Savings
Scorecard” calculates energy savings in kWH or dollars.

Detailed graphs show performance over user selected time scales. This data can be used to monitor
space and lighting usage, optimize time delays, and better utilize available daylight. Data is also provided

to the user in downloadable reports.

Green Screen Admin

Green Screen Log Overview Log Qut (scottl)

: # X % "‘Hm‘-‘“'- '.-HTllp“"'. # X Y 7 % F.
i IGHT sensorview Devices Channels Settings Profiles Schedules Users

Updates Plugins Reports

Services
Requires configured database,
BACnet see installation instructions {(PDF)
and Databases tab. Savings in
Green Screen kwh, dollars, or CO2. Generation
type affects CO2 savings. Electric
Show savings in [KWh [¥] Generation type *| | rates can be specified for time-of
|A|| coal fired E -day billing periods (e.g. peak/off
-peak). Configure baseline times
for when building is normally
occupied. Calculated savings are
period Rate (If rate is set to 0 or left blank, savings will relative to the cost of all control
be shown in kivh) points being on for duration of
Off-Peak S @ 21:00-7:00 baseline. See also Green Screen
Shoulder 1 o7 o0 7:00-9:00 datasheet (PDF).
Peak 02 Sl 5:00-17:00
Shoulder 2 0.17 2 0 17:00-21:00 |
Baseline - on time
Monday L @ 5:00-22:00
Tuesday ol @» ::00-22:00
Wednesday L @ 5:00-22:00
Thursday ol @ s:00-22:00
Friday ] @ 5:00-22:00
Saturday i O 5:00-13:00
Sunday L ] S 3:00-18:00
Service status: Running, Database size: 221.92 MB, Age data
after |14 days |

——————————————
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Green Screen requires a configured database (see _ and - tab).

The top pull-down allows users to select Savings in kWh, dollars, or CO2.
Generation type indicates a rate of CO2 production to energy consumption and affects CO2 savings.

Electric rates can be specified for time-of-day billing periods (e.g. peak/off-peak). Use the sliders to
define time intervals for a specific facility using nLight devices.

Baseline times should be configured for each day of the week, according to normal building occupancy.
Calculated savings are relative to the cost of all control points being on for the duration of the baseline.

The bottom line displays basic statistics and status about GreenScreen. It provides indications about the
current data aging setting, the size of the database on disk, and the current status of the GreenScreen
Plugin.

When configuration or changes are completed, click Save Settings.

See also Green Screen datasheet (PDF).
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Admin

Green Screen Log Log Out {scotil)

NLIGHT sensorview Lzemtmn Profiles

Updates Databases Plugins Reports

Location

You may edit your location in one
of two ways. If the "Edit
Coordinates"” box is checked,

Gateway Password

Gateways input your location via the
latitude and longitude boxes on
Gateway IP: | Discover, the right. If the "Edit

Coordinates"” box is unchecked,
you may edit your location

[ 10.65.67.52 Upstairs Gateway Online through the dropdowns below.
2 10.65.67.102 Training Roem online
This enables you to change your

current gateway password.

New gateways can be discovered
by IP, and existing gateways can
be deleted or excluded.

Update the settings here so that
lost passwords and other system
update information can be

———————————————

The Admin tabs are for administrators only, and will not be accessed by a day to day end user.
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Green Screen Log Overview Log Qut (scottl)

I'IG;HT SENSORVIEW

Setup Updates

SensorView Server
Gateway 000003FC

Time Zone and DST as:

Amenca/New York [=]

Gateway Password

Gateways

Databases

Devices

Plugins

For sunnse/sunset (astronomical time

offsets):

Choose nearest location:

Country:

[us

State:

[=]

| Connecticut

City:

=]

| New Haven

Latitude Morth Longitude East

(Degrees, Minutes) (Dearees, Minutes)

=]

[41 [13 [-73
[~ Edit Coordinates

s

m

Mail Server

Profiles

Reports

You may edit your location in one
of two ways. If the "Edit
Coordinates" box is checked,
input your location via the
latitude and lengitude boxes on
the right. If the "Edit
Coordinates" box is unchecked,
you may edit your location
through the dropdowns below.

This enables you to change your
current gateway password.

Mew gateways can be discovered
by IP, and existing gateways can
be deleted or excluded.

Update the settings here so that
lost passwords and other system
update information can be
accurately sent to you

——————————————

The Admin Setup screen displays four setup categories:
Location, Gateway Password, Gateways, and Mail Server.

Location

e Time zone — Select Time zone from pull-down menu

e Select Location — Country, State, nearest City
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Location settings allow a gateway to be aware of what time zone and daylight savings rules it should
apply. Specifying the location also allows the gateway to determine the proper astronomical time for
schedules using sunrise or sunset.

You may edit your location in one of two ways. If the “Edit Coordinates” box is checked, input your
location via the latitude and longitude boxes on the right.

If the “Edit Coordinates” box is unchecked, you may edit your location through the dropdowns below.
Gateway Password

This enables authorized users to change current gateway password. Configuring a gateway password
ties gateways to your particular SensorView, and prevents unauthorized users from using a different
SensorView to modify the system; as well as restricting direct configuration access to the gateways.
Gateways

New gateways can be discovered by IP, and existing gateways can be deleted or excluded.

Mail Server

Update the settings here in order to receive important system notifications.
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Updates

On this screen both software and device firmware updates are performed.

——
I'I(:; HT sensorview

Setup Updates

Software Updates

Current versicn: 7.1.134.30669
MNew version: 7.3.143.30844

Overview

Devices

Databases

" Control
Channels

S Group

Settings Profiles

Plugins

Firmware Cache Updates

Current version: 2011.09.07
New version: 2012.06.26

Log Out (scottl)

Schedules Users

Update Firmware Cache|

To update software:

1. On the server (nlight.sensorswitch.com) run the
installer

2. Select Modify and click Next

WallPod Updates

L

L nPOD GFX 00092DA3 000003FC X-Z-215 z-? None
L nPODS WH 0000AB11 000003FC Z-002-E £-003-E MNone
L nPOD GFX 00092DA4 000003FC X-H Z-1 None
L nPOD GFX 0038E620 000003FC X-H Z-1 None

Update Selected

e e

All updates are retrieved automatically from the internet and can be applied at the users’

discretion. Additionally a firmware cache component is available that allows users to perform device
updates without an active internet connection. Updates are only shown for components in which an
update is actually available.

It is recommended that users run the latest version of SensorView and device firmware to ensure
maximum efficiency and utility of nLight devices and networks.
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For step by step information on how to update SensorView please see SensorView Updates.

Databases

The Admin Database page allows you to create and load full system backups.

Green Screen Log Overview Log Qut (scottl)

f )] : ] \ DR oo :
" GHT sensonview Devices Channels Settings Profiles Schedules Users

Updates Databases Plugins

»

Backup 2011-06-22"10-20-54 AM s This page allows you to create
Backup_2012-03-95_05-34737_Pi and lead full system backups.
Backup_2012-03-21_04-18-38_PM H

Import_2011-02-01_09-33-57_AM )
Import_2011-02-01_11-43-07_AM When a successful backup is
Import_2011-02-03_08-45-59_AM made, an entry, complete with
Update Backup_2011-10-31_01-43-23_PM date and time stamp, will be
Update_Backup_2011-10-31_11-02-14_AM created to verify the process is
Update_Backup_2011-11-12_01-57-52_AM complete.

Update_Backup_2011-11-30_11-29-42 AM =
Backup name {opticnal): |

To restore or erase a backup,
click the desired entry followed

ks, by the appropriate Restore/Erase =
button below it.
Choose a local database backup
Import Database with the Browse button, then
Browse . |(_Import click Import to upload it and
F Save to backups overwrite the current database

with it. Click Export te download
the current database.

Export Database

Clear Database

DSN: | ssi-office-sv .
1. Postgres database, version

- 9.0 or higher
2. ODBC drivers for Postgres
3. DSN created
Installation instructions (PDF)

Database Selection (left side of browser) displays all databases available for your admin user account.
There are multiple types of databases from which to select.

e Automatic_Backup — Backup of a current or formerly active database. Databases are
automatically backed up daily (by default) and receive this label prefix.
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e Backup — a backup of a database that has been created on an as-needed or as-desired basis.
Administrators may backup the database at any time. To backup a database from the list, select
the desired database, enter a name in the “backup name” field, and click Backup.

¢ Import -an imported database

e Update — a database backup created while updating SensorView.

Backup, Erase, Restore Buttons
Any database selected from the list can be Backed up, Erased or Restored.

e Make Backup — When a successful backup is made, an entry, complete with date and time
stamp, will be created to verify the process is complete.

e Restore/Erase — To restore or erase a backup, click the desired entry followed by the
appropriate button.

e Import — Choose a database backup with the Browse button, then click Import to upload it and
overwrite the current database.

e Export — Click to download the current database.
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Plugins

The Admin dashboard for Plugins- Services, BACnet and Green Screen.

Services

Green Screen Log Overview Log Qut (scottl)

I'If:;HT SENSORVIEW

Updates

Configure which SensorView
plugins run. Green Screen and

nLight BACnet Gateway Stopped BACnet plugins require the nLight
nLight Green Screen Monitor Stopped PIUg'_" Host Service. To _update

- - - plugins first stop the nLight
nLight virtual Wallpod Server Running Plugin Host Service. Starting and

stopping a service requires

Green Screen and BACnet polling rate: | Normal : [ Save & Restart Service ] gdmmll_?atwe access to the
enso 2w server.

In order to start and stop nLight Flugin Host Service, please enter administrative
credentials (username, password, and domain) for the SensorView host machine:

Username
Password
Domain

nLight Plugin Host Service Running Stop

BACnet

Green Screen

——————————————

At upper left of the Services section each Plugin is listed along with its current status, either
Running or Stopped.

Green Screen and BACnet Polling rate
Controls the rate at which these plugins are being polled. Increasing the rate may allow for Change of
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Value notifications (BACnet) and GreenScreen reporting points to increase, but will result in additional
network traffic. To change the polling rate for these plugins, select a new rate, and click Save & Restart
Service.

The nLight Plugin Host Services status (either running or stopped) is indicated in the table below.

Controlling the nLight Plugin Host Service requires system administrator credentials (not SensorView
credentials). You may have to contact your local IT department to retrieve the proper set of credentials.

Administrators can enter their credentials (Username, Password, and Domain) for the SensorView host
machine, and click Stop or Start.

BACnet Admin Screen
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Log Out (scottl)

Updates

Services
Changes require restarting the
BACnet plugin before they take effect.
+ Local Server Port - port (UDP)
Local Server Port [47808 SensorView listens on for
Network Number 429 BACnet commands
. Network Mumber - number
Max APDU Length (1476 APDU Timeout(s £ e . . .
g () nLight devices reside under in
0 BACnet
Device Instance Base: |0 Group Instance Base: * Max APDU Length - maximum
097153 packet size BACnet server
accepts
Max string length: [1024 * APDU Timeout - timeout used

for BACnet messages

Save Settings + Device Instance Base - base
address (floor) nLight devices
Device Instance Base value has to be smaller than Group Instance Base value. use for BACnet instance
numbers
SensorSwitch BACnet Vendor ID: 429 ¢ Group Instance Base - base

address (floor) nLight groups
use for BACnet instance
numbers

¢+ Max String Length - maximum
length of BACnet commands
sent by SensorView. Allows
adjustment of labels if BACnet
server can't accept full
strings; drops remainder.

Green Screen

————————————————

BACnet administrative settings displayed are:

e Local server port — The port (UDP) on which SensorView receives BACnet commands

e Network Number — Number nLight devices reside under in BACnet. Default value is the nLight
BACnet Vendor ID, 429.

e Max APDU Length — maximum packet size BACnet server accepts

e ADPU timeout(s) — timeout used for BACnet messages
Defined by the ISO 7816 standards, the APDU (Application Protocol Data Unit) is the
communication unit between a reader and a card.

o Device Instance Base — base address (floor) nLight devices use for BACnet instance numbers

e Group Instance Base — base address (floor) nLight groups use for BACnet instance numbers
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e Max String Length — (default is 1024) maximum length of BACnet commands sent by
SensorView. Allows adjustment of labels if BACnet server can’t accept full strings; drops
remainder.

To change these settings enter the desired value in the appropriate field(s) and click Save Settings.
Device Instance Base must be smaller than Group Instance Base value.

The nLight Plugin Host Service must be restarted before the modified settings will take effect.
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Reports

Linked directly to the current active SensorView database, authorized administrators can view detailed
reports on the following:

Network Device Report: Creates a printable report containing basic information about the devices in
the network and their basic properties, such as Label, Device ID, Firmware Version, Zone, and parent
Bridge.

Profile & Scene Report: Creates a printable report describing the configuration of all profiles and scenes
currently in the system.

Device Settings Report: Creates a printable report describing the default settings for all nLight devices in
the system.

Global Channels / Preset Report: Creates a printable report listing all configured Global Channels along
with the devices broadcasting and tracking within them. Also listed is all Global Preset configurations
saved to any Global Preset capable device.

Discovery Report: Creates a printable report listing basic discovery statistics about all nGWY devices in
the system. This is generally used for diagnostic purposes only.

BACnet Inventory Report: Creates a CSV report that lists all BACnet devices available in the system. It
lists the Instance Numbers for all BACnet devices, as well as the instance values for all available
properties. This is typically provided directly to the BACnet integrator.
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Devices

On the SensorView Overview Device Properties page the user selects from the device tree. By default
these devices are listed in hierarchical order: gateways are parents of bridges, which are parents of
zones, each of which contain sensors, switches, relays, dimmers, or other devices.

Gateway Properties

nLight Network TREE / MAP

|¥ Training Reom
Back Bridge

nERG §

nERG 8 (ODOF706T)
nBRG § (0026855A)
nERG § (0DIC1619)
nERG B (0D1C1B4C)
nERG B (00IC1584)

P Hallway - Restroom
L
» Lobby
(Y
» Unizex AR 1
P Unizex AR 2

¥ BRIDGE 3
» Josh ¥ Basit info
B Mike
ot 7

 Senzoriisw Softwars

Rozat Il Rediacovar

s

Firmware Version: -00E / F194D002E

CEEE Label:
P Ber's Office
Notes: B
B Jarrod's Office id
¥ BRIDGE 5. [Gave)

b Conference Rosm
B Kitchen ¥ Advanced details
» Menz Room
P Oper. Office - North
» Oper Offica-South
B Port3
b Womens Room

¥ Bridge & New Arzz
¥ Jzster
P New Copy Room
P Prince
b Princess

¥ ABRE § (003A86CC)

Note that some items on Properties pertain only to certain types of devices and do not appear
otherwise.

™1
Device Count: GW: 1

Discovery:

Date Codes
Nip Server: 64
Associsted Profiles:

Basic Info:

e ID: An unique ID assigned to the device.

e Firmware Version: Indicates the firmware currently installed and running on the device. If this
number does not match information in the Overview screen under “Updates”, it may be time
for a fifmware Update.

e Label: This custom label should be used to describe and represent the device.

o Notes: (optional) Comments on this device or the area it serves.

e Load: (in Watts) Shows and/or sets the load on the selected device or devices within the
selected zone; used with Green Screen. Only applicable to devices containing relays or nlO
LEDs.

e Update Historical Load Data: This indicates whether to change the load for data points
previously collected for Green Screen (when checked) or leave old load values unaltered
(unchecked). Only applicable to devices containing relays or nlO LEDS.

Advanced detail
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e IP: The IP address of the selected gateway. nGWY only.

e Device Count: Shows the number of devices beneath this gateway in the network, including its
bridges and all devices below them. DB shows the number of database records associated with
the selected gateway, which should match the number of devices. Most SensorView users may
ignore this data, which is primarily used for network and system diagnostics. Also indicated are
the number of devices offline, if any. nGWY only.

e Discovery: Indicates the last time the selected Gateway was polled by SensorView. This occurs
when an instruction to the device is sent by a SensorView user, or a firmware update. You can
perform discovery any time by clicking Rediscover. nGWY only.

e Date Code: Indicates the internal lot number for the device.

e NTP Server: Network Time Protocol (NTP) is a protocol for synchronizing the clocks of computer
systems over a network. This is used to keep times on gateways in sync, and the NTP server’s IP
address is listed here. nGWY2 only.

e Parent Gateway: The name of the Gateway directly above the selected bridge in the network

hierarchy.

Network Depth: The number of steps below a gateway in the network hierarchy.

Associated Profiles: Profiles which include the selected device.

Zone: The name of the Zone in which the selected device resides.

Parent Device: The name of the device above the selected zone in the network hierarchy.

e BACnet Instance (Number) A device’s instance number is used to uniquely identify nLight
devices connected to BACnet.

The instance number is combined with other parameters in BACnet, such as Object Type or Object
Name. Because BACnet services many facilities and many different companies, the instance number
compensates for and eliminates any possibility of duplicate identifiers across the BACnet network. It is
similar to the WHOIS function for domain names on the Internet. Requesting devices across the network
can identify the device, its address information and its relative position in the network hierarchy. More
information on BACnet Instance Numbers.

Output Controls
Provides convenient controls for viewing the current status of the device, as well as modifying the
device’s outputs (relays or dimmers as appropriate).

Health
This section provides diagnostics read-outs for nLight Engineers and Field Techs.
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Control Channels

nLight Devices exchange control information via the use of Local and Global channels. Communication
performed within a Zone (single nBRG port) is dictated via Local Channels; while Global Channels allow a
device to receive input from any other device on the nLight network.

SensorView allows users to modify both Local and Global Channels to configure the control they
need. Local Channels are commonly used to subdivide a single Zone and allow for switches to control
individual fixtures or switch legs within a Zone, rather than all of them. Global Channels are more
commonly used to provide instantaneous switch control over the entire building with a master switch.

Channels, both Global and Local, can be used to fine tune the control that one devices has over others,
for Occupancy, Switching, and Daylighting.
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Local Channels

SensorView’s Local Channels tab allows a user to specify the channeling for all devices in the selected
zone. Users can configure Switching, Occupancy, and Photocell channels on a single screen.

Devices tracking a particular channel will respond to commands sent by any device broadcasting on that
channel. To configure one device to control another simply set the broadcasting and tracking numbers
for the devices to the same number. The column on the far right is a combined view, indicating all
devices broadcasting and tracking on the same channel, as changes are made this column will update.

Settings

- Devices Channels Profiles Schedules
nLIGHT scisorview

Channegls TSR LD PR Global Channels

[ Switch 9 Occupancy Photocell m—

Broadcastin channel 1
nlC next to door: nld next to door:
- ) Br | nlD next to door
nl0 next to door: nld next to door: nl0 next to door

nlQ over desk
nld over desk
APODM DX WiH (001A454C)

nlC over desk: nl0 over desk:

nlQ over deslk:
nPODM D WH (0014454 C):

nld over desk:
nPP16 (D000LESS ):

===

T nlO next to door
nl2 next to door
nld aver desk
nld over desk
nPP16 (000D01E34)

Channel 2

Br

Ir nld next to door

Channel 1
nZM POT 9 (00000045 : nlQ next to door:
= [BF  niCM POT 9 (00000045)

nlQ next to door:

nld over desk:

<

Tr  nlQ next to door
nl0 next to door
nlC ower desk
nlC over desk
APP1E (D0DO1E34)

nlQ over desk:

REEA

RPPL6 (O0DO1ES4):

Start by selecting a zone from the tree. Then configure channels (eg. make this switch control only the
lights at the back of the room) change the broadcasting channel of one or more devices to a new
number, and add that number to the tracking channels of one or more devices the broadcaster(s) should
affect. Add or remove tracking channels by expanding a drop-down and checking or unchecking the
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desired channels. Note that as changes to the channels are made the far right column will update to
indicate which devices are tracking/broadcasting on each channel.

Global Channels

With traditional wired nLight systems, devices within a zone communicate occupancy, photocell and
switch events over local channels.

With global channels, communication of this information is possible between zones as well. This
provides enhanced design flexibility for applications requiring master control stations or centralized
relays. Global channels are set through SensorView.

Select desired Switches from the Tree menu, and Select Switch on the Global Channels screen, and
select the Global Channel on which the desired devices will operate. Click to add desired Switches
(devices) to this

If no channel is yet defined, select New Channel. SensorView will display the next available Global
Channel.

Devices can be added to more than one channel if desired. Click New Channel to see the next available
Global Channel.

nWiFi Global Channel Functionality
Out of the box nWiFi devices communicate with other devices directly connected to them, but when

configured can use the WiFi network and global channels to link to other devices wirelessly and
communicate switch, occupancy, and/or photocell events.

EXAMPLE: Warehouse with multiple global channel assignments per device

For example, a common global channel would be tracked by devices within each colored area above.
On/Off & Dim Level control of each area is then possible via a standard WallPod. nWiFi devices can be
set to track any/all of the 128 global channels — providing the flexibility to assign each device into
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multiple groups based on its location or type (i.e., All Rows, Columns, Alternating, Load Shed eligible,
Custom, etc.). Simultaneous On/Off & Dim Level control of multiple global channel groups (referred to
as “global preset”) is possible via a Scene Selector WallPod.

nWiFi Global Commands

Devices

Local Channels

SensorView Manual

Log Out (administrator)

—

Group
Settings

Global Channels

To create groups of devices that will switch on and off together, click on the Control Channels tab at the
top right of the page followed by the Global Channels tab. The tree will expand and display all of the
devices that can broadcast and track events over the nWIFI network.

Channels

| switch 3 __Occupancy 2 Photocell D —

hannel A

hannel B

hannel C

hannel D

hannel E

hannel F

hannel G

hannel H

hannel |

hannel K

New Channel

1 broadeasting devices

1 broadcasting devices

0 broadcasting devices

0 brozdasting davices

1 breadeasting devices

0 broadcasting devices

1 breadeasting davices

nPODM 4P WH (00417 E92) Po

0 broadcasting devices

0 brozdasting davices

1 breadeasting davices

1

1 tracking devices

1 tracking devices

1 tracking devices

1 tracking devicas

1 tracking devices

1 tracking devices

1 tracking devicas

Bed 2 PP

1 tracking devices

1 tracking devicas

2 tracking devices

Any Global Channels that have been previously assigned will be displayed. A maximum of 128 Global
Channels are available. To view or edit the devices that are part of a global channel expand the channel
by clicking the arrow next to the channel name. Click the box under Broadcasting Devices or Tracking
Devices to add or remove devices from that group using the device tree.

Garage 2
¥ Wi-Fi Zone 11

NCMRB 6 WIFT (0042865F)
¥ Wi-Fi Zone 6

Bed 4 PP

Bed 4 robe
¥ Wi-Fi Zone 7

¥ Wi-Fi Zone 9
Garage 1

© Channel G

© ChannelH
© | Channel |

© Channel K

New Channel

1 broadcasting devices

nPODM 4P WH (00417E92) Pole 1

0 broadeazting devices

0 broadcasting devices

1 broadcasting devices

2 tracking devices

[>] Bed 30D
Office PR

L tracking devizas
1 tracking devices

2 tracking devices

After setting up the desired channels, click Finish followed by Save Global Channels.
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Global channels saved

Channels

Photocell
Saving settings may take a moment..| | _Save Global Channels.

Successfully saved settings.

To create a new Global Channel click the New Channel button, change the default label if desired, and
select Broadcasting or Tracking to begin adding devices from the tree.

© | Channel K 1 broadcasting devices 2 tracking devices
© | New Channel 1 broadcasting devices 0 tracking davices

nPOD GFX (0024AE37) WallPod 1 o click to add devices

New Channel

To select (or deselect) multiple devices at once in the tree click the box next to a top-level device, such
as a gateway or nlLight Config Tool, to affect everything below it.

Tip: Channels used in a global preset shouldn’t contain the same devices to prevent On/Off conflicts.
e.g., a preset where 50% of all lights go on and the other half go off, two global channels are required
(one for the On command & the other for Off).

Global Preset: a combination of global channels commands (on/off/dim level) activated simultaneously
by a device. Each global preset can feature different commands on different channels. A global preset
can contain between 1 and 80 Global Channels.

For example: a Scene Selector can simultaneously send an On command to all devices tracking global
channel A and an Off command to all devices tracking global channel B.

To set a Global Preset on a Graphic WallPod (nPOD GFX), find the device in the tree on the Devices page
and click the Scenes tab.
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€ | O | localhost/SensorView/Main.aspx#pnlinfoContent

nLight Network

¥ nlight Config Teal
¥ nBRG 3 (00168814)

* Port 3

¥ Port 8
nl0 (000BB35A)
nFanel 44 (0010CaCE)
nPane| 48 (001DCECC
RPOD 37) Scene &
nFODM 45 WH (00437919) Scene 7
nPODS WH (0000AB3F)
* Wi-Fi Zone 10
* Wi-Fi Zone 11
» Wi-Fi Zone 6
» Wi-Fi Zone 7
» Wi-Fi Zone 8
* Wi-Fi Zone 9

Mode: | Disabled =

Name:

Scene 8

Mode: | Global F‘resetE .
Change the mode to Global Preset and select the desired global channels.

Once they have been selected set them to On, Off, or a Dim Level (if dimming hardware is installed) and
click Save.

e Mods: GlobalPresei[=]
Scene 2 Channel B e
Scene 3 e o- | el
Scene 4 Channel E a
Scene 5 { o | | on ) OFF
Scene 6
[Add 2 chamnel []
Scene 7
Scene 8

Log Out (administrator]

|" Control | | Group

Channels CSattin

Properties | Current Settingd S ETUHSISTNES 4

nPODM 45 WH (00 913) (nPULIM 45 WH) | £ZoneDevice]

To set a Global Preset for an nPOD(M) device, find device in the tree on the Devices page and select the
Default Settings tab near the top right of the page.

Change the mode to Global Preset and select the desired global channels. Once selected set them to On,
Off, or a Dim Level (if dimming hardware installed) and click Save.
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Name: | Mode: |Global Preset[¥]
Button 2 Channel A
Button 3 mﬂ] OFF
Button 4 Channel G
o on | 100%
[Add a channel [=]

Global Presets are resent every time the button on the device is pushed; if any fixture(s) does not
respond to the Global Preset, resend by pressing the button again.
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Group Settings

Here default settings can be modified for many devices at once. Start by selecting devices from the tree,
which will show a drop-down to add a setting. The list of settings available depends on the devices
selected.

Add one or more settings, then select the desired value(s). When finished, click Save Defaults.

Selecting Multiple Devices from the Tree

MultiSelect is a selection mode offered by SensorView’s tree. When operating in this mode, all line
items displayed in the tree will be given a checkbox which will allow for selection. Single clicking on a

device no longer displays information specific to the device, but rather selects/deselects it.

This mode of selection is used when large amounts of devices are to be operated on simultaneously.

Bridge Selected
None Selected (Palregnt atewa Zone expanded. Specific zone devices
(empty Checkboxes) g. v All zone devices checked unchecked
checked in gray)
nLight Network TREE / MAP 13 selected TREE / MAP

Find devices Find devices

A EEEEEEEN
A EEEEEEEN
EEEEEEEN

AAAEEAN A EEEEEE R RN

L] L]
L] L]
L L
L] L]
L L
L L
L] L]
L L
L | L |
V1 v
A A
v v
v V1
L A
L VA
L] V1
L A
L v

Selecting a zone device (a device that exists in a zone) only selects/deselects that device. Selecting a
zone, bridge, or gateway selects/deselects children; this allows for a user to quickly select all devices in a
zone, bridge, or gateway.
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Profiles

Admin Green Screen Log Owverview

3
. _ - Control
I'IG HT i S Channels i Solleitle

nLight Network TREE / MAF  Profiles Settings

The Profiles tab is where control modes and settings for a particular group are selected. A schedule
(complete with a recurrence pattern) and priority are also chosen on this page.

Profiles are stored in the database and the Gateway, which administers profiles according to priorities.
The profiles can also be activated on demand via SensorView or the Gateway.

Click New to start creating a new profile, or the name of a profile in the list to edit an existing profile.

Add or remove devices using the checkboxes in the tree on the left. Checked devices can participate in
the profile and receive applicable settings while the profile runs.

Scheduler
e Schedule date/hour/minute for any setting change or control mode
e Astronomical start/end dates include +/-180 minute deviance from Sunrise/Sunset
e Set daily/weekly/monthly/yearly recurrences; drilldown options provide more detailed patterns

Priority:
e Select the priority of the profile to change, then use the arrows to move to the appropriate
position, or down into the disabled area

Unlike other systems which allow scheduling of lights on/off or on-demand dimming scene control,
nLight provides users with the ability to schedule changes to almost any operational parameter. This
allows for dynamic sequences of operation that can be tailored to a space across different times of day
and/or dates.
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Schedules

The Schedules tab shows all scheduled profiles for zones and devices in the nLight network, on a 24-
hour schedule for a given date.

Hovering over a profile name displays the profile’s begin and end times. Clicking the profile name is a
shortcut to editing that profile on the Profiles tab.

When a zone is expanded, individual schedule bars for the zone’s devices are generated. These bars are
colored to denote a specific profile.

Clicking the header with the time markings will bring up a date picker for quick viewing of a future date.

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 111 of 123



<AcuityControls.

nLight. .
SensorView Manual

Users

The Users tab manages users and their permissions to nLight devices and Virtual WallPods.

nLight Network TREE / MAP User Accounts

d I [ =
-

W Training Room

K Bri —  User details
Back Bridge
Email Password
BRG 8 p
! | steve@sensorswitch_com |
nBRG 8 (000F7D&0)
nBRG 8 (00168B5A) Confirm password

nBRG 8 (001C1819) |
nBRG 8 (001C184C)
nBRG 8 (001C1894)
¥ Upstairs Gateway
¥ BRIDGE 1
IT Room
¥ BRIDGE 2
Hallway - Restroom

Virtual switches

m

Jay

Lobby

N/A

Unisex RR 1

Unisex RR 2
¥ BRIDGE 3

Jash

Mike

Port 7
¥ BRIDGE 4

Ben's Office

Jarrod’s Office
¥ BRIDGE 5

Conference Room

At the top, under User Accounts, is a drop-down that lists users. Select a user to display and edit the
user’s details.

You may assign one or more Virtual Switches to a user by clicking Add Switch. The newly added switch
can be labeled using the text field. Select either Zone Channel or an Individual device from the Control
Type drop-down.

For zone channel switches Select Zone from the drop-down. Individual devices associated with that zone
will be displayed beneath. For individual device Select device to control, and it will be added to your list.
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When finished click Save.
Adding, Modifying, and Deleting Users

To add a user select Add a user from the drop-down. Or select a username to edit that user. Clicking
Delete user will delete the user selected in the drop-down.

Users you control, other than yourself, can be one of several user types, which dictates their level of
capabilities within SensorView.

e Read-only users are only allowed to view status and current settings from the devices they are
given permission to; they are not allowed to affect any sort of change to the system.

e Basic users are allowed to read and configure the devices within their permissions, including
managing profiles for (just) those devices.

e Administrators have access to the Admin page. In addition to Basic User tasks for their
permission set, Administrators are also allowed to run updates and manage SensorView
(location, gateway passwords, mail servers, and users).
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SensorView Terms

R/

¢ 100 Hour Burn-In: Overrides relay on and/or dimming output to full bright (typically
used for lamp seasoning)

+ Auto Set-Point: Photocell calibration procedure for detecting optimum lighting control
level

+* Auto to Override On: Special Mode where lights are turned on initially by occupant
detection but then left in the Override On state

» BACnet Instance (Number) A device’s instance number is used to uniquely identify

nLight devices connected to BACnet.

The instance number is combined with other parameters in BACnet, such as Object Type
or Object Name. Because BACnet services many facilities and many different companies,
the instance number compensates for and eliminates any possibility of duplicate
identifiers across the BACnet network. It is similar to the WHOIS function for domain
names on the Internet. Requesting devices across the network can identify the device,
its address information and its relative position in the network hierarchy. More
information on BACnet Instance Numbers.

>

R/
*

BMS (Building Management System)
A Building Management System (BMS) is a network which monitors and/or controls
devices in a building, campus, or in multiple facilities.

*,

When used for monitoring, the BMS polls and displays information from various types
of equipment. BMS may monitor alarm conditions for equipment dependent up
humidity or temperature. SensorView polls nLight devices, for example, and collect
sensor information on occupancy, light levels, microphonic activity, among others.

When used as a control system, the BMS has the ability to change settings on
networked devices. This can be done manually by facilities/BMS managers, or by pre-
programmed conditions, where settings of devices are modified in response to readings
collected by other networked devices. Slave devices pass data from sensors to the
master, which processes collected data and issues instructions for any necessary
settings changes. Instructions can also be issued to devices based on Profiles which may
be scheduled to start at a certain time of day, or triggered by readings and thresholds of
other devices. nLight products integrate with BMSs using Internet protocols and open
standards such as BACnet.

7/
X4

L)

Broadcast Analog Input: Input mode that senses a 0-10 VDC input
Button Mode: Overrides a device and enables its push-button to toggle the device’s
internal relay(s) or dim level

R/

+» Dimming Offset: Fixed voltage difference of dimming output from dimming photocell

K/
X4

)

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 114 of 123


http://www.bacnet.org/Bibliography/ES-7-96/ES-7-96.htm

<AcuityControls.

nlLight. .
SensorView Manual

X/ X/ X/
°e °e °e

X/
X4

L)

X3

*

X/
X4

L)

X/ X/
L XA X4

>

K/
X4

D)

>

K/
*

K/ K/
R X X4

K/
X4

)

Dimming Rate: The speed at which automatic changes to the light level occur

Dual Technology (Microphonics): A second method of occupancy detection that allows
the sensor to hear occupants

Dual Zone Fan Mode: Dual Zone photocell mode where Zone 2’s photocell control is
disabled

Dual Zone Off-Point: Zone 2’s set-point as a percentage of Zones 1’s set-point (Dual
Zone photocell applications only)

Dual Zone Offset: Fixed voltage increase of Zone 2’s dimming output from Zone 1’s
dimming output (Dual Zone photocell applications only)

Dual Zone Offset Mode: Dual Zone photocell mode where Zone 2’s set-point is a
selected percentage higher than Zones 1’s set-point

DZ Photocell Mode: Indicates a Dual Zone photocell sensor’s method of operation
Enabled - Both Positive and Negative: User can increase or decrease lighting level set by
dimming photocell

Enabled — Negative Only: User can decrease lighting level set by dimming photocell

Follow Photocell Mode: Instructs how a device’s dimming output reacts relative to a
dimming photocell

Idle Time Until Dim: The length of time after last detected occupancy that a sensor will
reduce lighting to unoccupied dim level.

Incremental Set-Point Adjust: Alters the target light level that is to be maintained by
the device (in footcandles)

Invert Relay Logic: Reverses functionality of relays

LED: Indicates the behavior of a device’s LED

Local Only Occupancy Tracking: Instructs a device with a relay and/or dimming output
to react to only its internal occupancy information

Local Only Photocell Tracking: Instructs a device with a relay and/or dimming output to
react to only its internal photocell information

Local Only Switching Tracking: Instructs a device with a relay and/or dimming output to
react to only its own manual switching and/or dimming events

Manual On to Full Auto: Special Mode that initially requires the occupant to manually
turn on the lights, after which the sensor assumes full on/off control

Manual to Override On: Special Mode that requires the occupant to manually turn on
the lights and then leaves them in the Override On state

Microphone Grace Period: The time period after lights are automatically turned off that
they can be reactivated by sound

Momentary: Input mode that senses a pulse style switch

Night Light Brightness: The percent of full brightness the push-buttons LED illuminates
Network Time Protocol (NTP) is a protocol for synchronizing the clocks of computer
systems over a network. nLight gateways are synchronized with an NTP Server.
Occupancy Broadcast Channel: The channel on which a sensor transmits its occupancy
information

Occupancy Broadcasting: Indicates whether a sensor will transmit its occupancy
information to the rest of its zone
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Occupancy Tracking: Indicates whether a device’s relay and/or dimming output will
react to occupancy information

Occupancy Tracking Channel: The channel on which a relay and/or dimming output
receives occupancy information

Occupied Bright Level: The output level (0-10 VDC) that a dimming sensor sets the
lights when occupancy is detected (not applicable if photocell is enabled).

Override: Indicates whether a device’s relay is forced on/off and/or dimming output is
forced to maximum/minimum

Photocell Broadcast Channel: The channel on which a sensor transmits its photocell
information

Photocell Broadcasting: Indicates whether a sensor will transmit its photocell
information to the rest of its zone

Photocell Dimming Range (High): The maximum output level (0-10 VDC) up to which an
automatic dimming photocell will control

Photocell Dimming Range (Low): The minimum output level (0-10 VDC) down to which
an automatic dimming photocell will control

Photocell Mode: Indicates a photocell sensor’s method of operation. One mode
enables the sensor to turn the lights both on and off while the other mode can only
inhibit (prevent) the lights from turning on

Photocell Tracking: Indicates whether a device’s relay and/or dimming output will react
to photocell information

Photocell Tracking Channel: The channel on which a relay and/or dimming output
receives photocell information

Photocell Transition Off Time: The time period for which a photocell must measure a
light level above the set-point before it will turn the lights off

Photocell Transition On Time: The time period for which a photocell must measure a
light level below the set-point before it will initiate the lights on

Predictive Exit Time: The time period after manually switching lights off for the
occupant to leave the space (Predictive Off mode only)

Predictive Grace Period: The time period after the Predictive Exit Time that the sensor
rescans the room for remaining occupants (Predictive Off mode only)

Predictive Off: When lights are switched off, this Special Mode determines whether
occupants remain or left the room, so as to leave the lights in either the Override Off or
Auto On state.

Profile Mode: Mode that commands a Gateway to run any number of specified profiles
Profile Override: Whether profiles selected via a Scene Controller button will cancel out
or run concurrently with other profiles.

Reduced Turn-On: Reduces the initial PIR detection strength; for use in areas where
reflections are in sensor’s view

Scene Expiration Time: The length of time a selected scene or profile will run before
automatically disengaging and reverting affected devices back to defaults

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15

Page 116 of 123



<AcuityControls.

nlLight. .
SensorView Manual

X/
°e

X/
°e

X/
X4

L)

X/
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X/
X
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L)

Scene Mode: Mode that causes button to initiate pre-programmed settings on devices
within a local zone

Scene Mode — Momentary: Mode where pre-programmed settings are run on devices
within a local zone when a pulse style switch is sensed from the connected device
Scene Mode — Toggle: Mode where pre-programmed settings are run on devices
within a local zone when an open/close style switch is sensed from the connected
device

Semi-Auto: Special Mode that requires the occupant to manually turn the lights on,
while having them turn off automatically by a sensor

Semi-Auto Grace Period: The time period after lights are automatically turned off that
they can be reactivated with movement

Set-Point: The target light level that is to be maintained by the device (in foot-candles)
Special Modes: Unique defined behaviors for relays and/or dimming outputs
Start-to-High: Lights go to full bright for 20 minutes upon initial power up

Stepped Dimming (DUO) Mode: Dual Zone photocell mode where the appropriate
on/off combination of the two associated relays is maintained in order to always meet
the photocell set-point requirements

Stepped Dimming (DUO) — Never Off: Dual Zone photocell mode where the
appropriate on/off combination of the two associated relays (except both off) is
maintained in order to always meet the photocell set-point requirements

Sunlight Discount Factor: Value used to improve the tracking accuracy of a photocell
during periods of high daylight; decreasing the value will lower the controlled level of
the lights

Sweep Exit Time: The time period before a sweep is executed, setting time delays on
affected devices to zero

Sweep Grace Period: The time delay before a sweep is executed, so a user pressing a
switch to activate the sweep may exit the room or building before the sweep occurs
Sweep Mode: Mode that causes a Scene Controller button to set the remaining time
delay for all devices on a gateway

Sweep Mode — Momentary: Mode that sets the remaining time delay for all devices on
a gateway when a pulse style switch is sensed from the connected device

Sweep Mode — Toggle: Mode that sets the remaining time delay for all devices on a
gateway when an open/close style switch is sensed from the connected device.

Switch Broadcast Channel: The channel on which a device with a manual switch and/or
dimmer transmits

Switch Broadcasting: Indicates whether a device with a manual switch and/or dimmer
will transmit events to the rest of its zone

Switch Tracking: Indicates whether a device’s relay and/or dimming output will react to
manual switching or dimming events

Switch Tracking Channel: The channel on which a relay and/or dimming output receives
manual switching or dimming events
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+» Timed Override Delay: The length of time an Override On state that is initiated by a
Special Mode will remain in effect

+» Toggle Mode: Input mode of a nlO that senses an open/close style switch

+* Unoccupied Dim Level: The output level (0-10 VDC) a dimming sensor sets the lights
after the idle time until dim timer expires

*» WallPod Dimming Adjustments: Indicates whether user adjustments to dimming levels

are stored to device defaults (Permanent) or not (Temporary)

Wallpod Mode — Momentary: Mode that creates an equivalent WallPod signal when a

pulse style switch is sensed from the connected device.

Wallpod Mode - Toggle: Mode that creates an equivalent WallPod signal when an

open/close style switch is sensed from the connected device

+* WallPod Mode: Mode that causes a Scene Controller button to function like a WallPod

¢

o
A5

X/
°e
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Icon

Value

Description

Bridge / Transceiver PowerState
Power Supply Voltage: (VDC)

Device has adequate power (bridge)

Bridge / Transceiver PowerState
Power Supply Voltage: (VDC)

Device is close to low power condition (bridge)

N

Bridge / Transceiver Power State
Power Supply Voltage: (VDC)

Device is in low power condition (bridge)

Broadcasting & Tracking Status

Icon

Value

Description

Occupancy Broadcasting

Occupancy status broadcast is active

Occupancy Tracking

Occupancy status tracking is active

Photocell Broadcasting

Photocell status broadcast is active

Photocell Tracking

Photocell status tracking is active

Switch Broadcasting

Switch status broadcast is active

(P (@)

Switch Tracking

Switch status tracking is active

Scenes & Profiles Status

Icon

Value

Description

Scene States (per button/nlO)
Scene State: Active

Scene associated with button is active

I &

Scene States (per button/nlO)
Scene State: Idle

Scene associated with button is not active
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Scene States (per button/nlO)
Scene State: Disabled

Button is disabled

Scene Expiration Time

Indicates when current running scene/profile
will expire

Photocell Not Inhibiting

Indicates that photocell is not preventing
lights from being on

Photocell Status (per pole)
Transition time: (hh:mm:ss)

Indicates when current photocell state will
change

ICIICH

Current temperature at the processor of the
Y ic Temperature .
| device
LightLevel Current foot candle level as measured by the
Measured light level: (fc) photocell

Profile Active

Profile is currently active

Profile Inactive

@ e

Profile is NOT currently active

Photocell Status

Icon Value

Description

Photocell Inhibiting

Indicates that photocell is preventing the
lights from being on

Photocell Not Inhibiting

Indicates that photocell is not preventing
lights from being on

Indicates when current photocell state will
change

LightLevel
Measured light level: (fc)

Photocell Status (per pole)
Transition time: (hh:mm:ss)

Current foot candle level as measured by the
photocell

PIR & PDT Status

| Icon | Value

Description
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Time Delay Remaining:
(hh:mm:ss)

Indicates when current occupancy state will
expire

Tracked Occupancy Timer

Reason why pole is open or closed

PIR Activity

PIR Activity detected/detecting occupant
motion

PIR Activity

No PIR Activity. PIR not currently detecting
occupant motion

Microphonic Activity

Microphone has detected a triggering noise

S S HHKOGG

Microphonic Activity

Microphone is not currently detecting noises

Occupancy, Relay & Dimming Status

Icon Value Description
' Occupied Room is occupied
Vacant Room is not occupied

®
Dimming Output (input) level: (%) Current % of 0-10 VDC scales

.. ]

L ) Follow Photocell Level: 4.9% or Input Dim
Input Dim Level

.- L P Level: 100%

Pole State Reason

Reason why pole is open or closed

Accumulated Hours

Accumulated Hours: 1272

v
®
=9

Compensated Output Level

Compensated Output Level: 0
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Pole State reason: Manual Switch Override
Off

v

Relay State (per pole)

Closed

(&

Relay State (per pole)

Open

Wireless Status

Icon

Value

Description

Wireless Signal Strength: (1- 5)

Indicates wireless signal strength (higher is
better)

Wireless PAN ID

Wireless panel identification number

Wireless Node ID

Wireless node identification number

Wireless Channel: (11-26)

Indicates the wireless channel currently being
used

Wireless State:

Wireless States:

e Normal

e Validating the network

e Searching for a network that is
allowing joining

e  Creating a new network

e Allowing joining

e  Cloning is happening in the system

e  Multiple SSI networks are allowing
joining

e Lost aremote device during OTA
cloning

e  Wireless device is not responding

/4
&

3
<f-1“l-ll‘?
o)

Bridge Port Information

Port States:
e  Polling downstream devices
e  Upstream port
e Commissioning tool connected
e Polling downstream bridges

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15

Page 122 of 123



<AcuityControls.

nLight. .
SensorView Manual

Error: Too many adds/deletes (reset
bridge)
e  Error: Local loop

3
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y

mﬁg“ﬂ e Error: Non-local loop
\E\% e  Error: Devices connected between
bridges
T
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Number of downstream wireless Bridges
and Transceivers

Port States:

e  Polling downstream devices

e  Upstream port

e  Commissioning tool connected

e  Polling downstream bridges
Transceiver Port Status e  Error: Too many adds/deletes (reset
bridge)
Error: Local loop
e Error: Non-local loop
e  Error: Devices connected between
e bridges

N 3

-3

&) Number of downstream wireless Bridges &

Transceivers

g )
_\_.'.
W

Acuity Brands | One Lithonia Way Conyers, GA 30012 Phone: 800.535.2465 www.acuitycontrols.com © 2014-2015 Acuity Brands Lighting, Inc. All rights reserved. 11/3/15
Page 123 of 123



